
Microsoft Offi ce Word 2007

Creating a 
Research Paper2

Objectives
You will have mastered the material in this chapter when you can:

• Describe the MLA documentation 
style for research papers

• Change line and paragraph spacing 
in a document

• Use a header to number pages of a 
document

• Apply formatting using shortcut keys

• Modify paragraph indentation

• Create and modify styles

• Insert and edit citations and their 
sources

• Add a footnote to a document

• Insert a manual page break

• Create a bibliographical list of sources

• Move text

• Find and replace text

• Use the Research task pane to look 
up information
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2 Creating a 
Research Paper
Introduction
In both academic and business environments, you will be asked to write reports. Business 
reports range from proposals to cost justifi cations to fi ve-year plans to research fi ndings. 
Academic reports focus mostly on research fi ndings. A research paper is a document 
you can use to communicate the results of research fi ndings. To write a research paper, 
you learn about a particular topic from a variety of sources (research), organize your ideas 
from the research results, and then present relevant facts and/or opinions that support the 
topic. Your fi nal research paper combines properly credited outside information along with 
personal insights. Thus, no two research papers — even if about the same topic — will or 
should be the same.

Project — Research Paper
When preparing a research paper, you should follow a standard documentation style that 
defi nes the rules for creating the paper and crediting sources. A variety of documentation styles 
exists, depending on the nature of the research paper. Each style requires the same basic 
information; the differences in styles relate to requirements for presenting the information. 
For example, one documentation style uses the term bibliography for the list of sources, 
whereas another uses references, and yet a third prefers the title works cited. Two popular 
documentation styles for research papers are the Modern Language Association of 
America (MLA) and American Psychological Association (APA) styles. This chapter 
uses the MLA documentation style because it is used in a wide range of disciplines.

The project in this chapter follows research paper guidelines and uses Word to create 
the short research paper shown in Figure 2–1. This paper, which discusses three types of 
wireless communications, follows the MLA documentation style. Each page contains a page 
number. The fi rst two pages present the heading (name, course, and date information), 
paper title, an introduction with a thesis statement, details that support the thesis, and a 
conclusion. This section of the paper also includes references to research sources. The third 
page contains a detailed, alphabetical list of the sources used in the research paper. 

Overview
As you read through this chapter, you will learn how to create the research paper 

shown in Figure 2–1 by performing these general tasks:

• Change the document settings.
• Type the research paper.
• Save the research paper.
• Create an alphabetical list of sources.
• Proof and revise the research paper.
• Print the research paper.
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parenthetical 
citation

superscripted note 
reference mark

alphabetical list 
of sources

explanatory note 
positioned as footnote

header contains last 
name followed by 
page number

Figure 2–1
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General Project Guidelines
When creating a Word document, the actions you perform and decisions you make will affect 
the appearance and characteristics of the fi nished document. As you create a research paper, 
such as the project shown in Figure 2–1 on the previous page, you should follow these 
general guidelines:

1. Select a topic. Spend time brainstorming ideas for a topic. Choose one you fi nd interesting. 
For shorter papers, narrow down the scope of the topic; for longer papers, broaden the 
scope. Identify a tentative thesis statement, which is a sentence describing the paper’s 
subject matter.

2. Research the topic and take notes. Gather credible, relevant information about the topic 
that supports the thesis statement. Sources of research include books, magazines, news-
papers, and the Internet. As you record facts and ideas, list details about the source: title, 
author, place of publication, publisher, date of publication, etc. When taking notes, be 
careful not to plagiarize. That is, do not use someone else’s work and claim it to be your 
own. If you copy information directly, place it in quotation marks and identify its source.

3. Organize your ideas. Classify your notes into related concepts. Make an outline from the 
categories of notes. In the outline, identify all main ideas and supporting details.

4. Write the fi rst draft, referencing sources. From the outline, compose the paper. Every research 
paper should include an introduction containing the thesis statement, supporting details, 
and a conclusion. Follow the guidelines identifi ed in the required documentation style. 
Reference all sources of information. 

5. Create the list of sources. Using the formats specifi ed in the required documentation style, 
completely list all sources referenced in the body of the research paper in alphabetical order.

6. Proofread and revise the paper. If possible, proofread the paper with a fresh set of eyes, 
that is, at least one to two days after completing the fi rst draft. Proofreading involves 
reading the paper with the intent of identifying errors (spelling, grammar, etc.) and 
looking for ways to improve the paper (wording, transitions, fl ow, etc.). Try reading the 
paper out loud, which helps to identify unclear or awkward wording. Ask someone else 
to proofread the paper and give you suggestions for improvements.

When necessary, more specifi c details concerning the above guidelines are presented at 
appropriate points in the chapter. The chapter also will identify the actions performed and 
decisions made regarding these guidelines during the creation of the research paper shown 
in Figure 2–1.

Plan 
Ahead

MLA Documentation Style
The research paper in this project follows the guidelines presented by the MLA. 

To follow the MLA style, double-space text on all pages of the paper using one-inch top, 
bottom, left, and right margins. Indent the fi rst word of each paragraph one-half inch 
from the left margin. At the right margin of each page, place a page number one-half inch 
from the top margin. On each page, precede the page number by your last name.

The MLA style does not require a title page. Instead, place your name and course 
information in a block at the left margin beginning one inch from the top of the page. 
Center the title one double-space below your name and course information.

In the text of the paper, place author references in parentheses with the page 
number(s) of the referenced information. The MLA style uses in-text parenthetical 
citations instead of noting each source at the bottom of the page or at the end of the 
paper. In the MLA style, notes are used only for optional explanatory notes.

If used, explanatory notes elaborate on points discussed in the paper. Use a super-
script (raised number) to signal that an explanatory note exists, and also to sequence the 
notes. Position explanatory notes either at the bottom of the page as footnotes or at the 
end of the paper as endnotes. Indent the fi rst line of each explanatory note one-half inch 
from the left margin. Place one space following the superscripted number before 
beginning the note text. Double-space the note text. At the end of the note text, you may 
list bibliographic information for further reference.

APA Documentation 
Style
In the APA style, a 
separate title page 
is required instead 
of placing name and 
course information on 
the paper’s fi rst page. 
Double-space all pages of 
the paper with 1.5” top, 
bottom, left, and right 
margins. Indent the fi rst 
word of each paragraph 
.5” from the left margin. 
In the upper-right margin 
of each page, including 
the title page, place 
a running head that 
consists of the page 
number double-spaced 
below a brief summary of 
the paper title. 

B
T
W
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The MLA style uses the term works cited to refer to the bibliographic list of 
sources at the end of the paper. The works cited page alphabetically lists sources that are 
referenced directly in the paper. Place the list of sources on a separate numbered page. 
Center the title, Works Cited, one inch from the top margin. Double-space all lines. 
Begin the fi rst line of each source at the left margin, indenting subsequent lines of the 
same source one-half inch from the left margin. List each source by the author’s last name, 
or, if the author’s name is not available, by the title of the source. Underline or italicize the 
title of each source. 

Changing Document Settings
The MLA documentation style defi nes some global formats that apply to the entire 
research paper. Some of these formats are the default in Word. For example, the default 
left, right, top, and bottom margin settings in Word are one inch, which meets the MLA 
style. You will modify, however, the paragraph and line spacing and header formats as 
required by the MLA style.

After starting Word, the following pages adjust line and paragraph spacing and 
defi ne a header for the current document.

To Start Word

If you are using a computer to step through the project in this chapter and you want your 
screens to match the fi gures in this book, you should change your computer’s resolution to 
1024 � 768. For information about how to change a computer’s resolution, read Appendix E.

The following steps, which assume Windows is running, start Word based on a typical 
installation. You may need to ask your instructor how to start Word for your computer.

1  Click the Start button on the Windows taskbar to display the Start menu, and then point 
to All Programs on the Start menu to display the All Programs submenu.

2  Point to Microsoft Offi ce on the All Programs submenu to display the Microsoft Offi ce 
submenu, and then click Microsoft Offi ce Word 2007 to start Word and display a new 
blank document in the Word window. 

3  If the Word window is not maximized, click the Maximize button next to the Close button 
on its title bar to maximize the window.

4  If the Print Layout button is not selected, click it so your screen layout matches Figure 2–2  
on the next page.

5  If your zoom percent is not 100, click the Zoom Out or Zoom In button as many times as 
necessary until the Zoom level button displays 100% on its face.

Changing Document Settings   WD 77

To Display Formatting Marks

As discussed in Chapter 1, it is helpful to display formatting marks that indicate 
where in the document you pressed the ENTER key, SPACEBAR, and other keys. The following 
step displays formatting marks.

1  If necessary, click Home on the Ribbon to display the Home tab. If the Show/Hide ¶ button 
on the Home tab is not selected already, click it to display formatting marks on the screen.
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1
• Click the Line spacing 

button on the Home 
tab to display the 
Line spacing gallery 
(Figure 2–2).

What do the numbers 
in the Line spacing 
gallery represent?

The default line 
spacing is 1.15 lines. 
The options 1.0, 2.0, 
and 3.0 set line 
spacing to single, 
double, and triple, 
respectively. 
Similarly, the 1.5 and 
2.5 options set line 
spacing to 1.5 and 
2.5 lines. All these 
options adjust line 
spacing automatically 
to accommodate 
the largest font or 
graphic on a line.

2
• Click 2.0 in the Line 

spacing gallery to change the line spacing to double at the location of the insertion point.

Can I change the line spacing of existing text?

Yes. Select the text fi rst and then change the line spacing as described in these steps.

Adjusting Line and Paragraph Spacing
Line spacing is the amount of vertical space between lines of text in a paragraph. 

Paragraph spacing is the amount of space above and below a paragraph. By default, the 
Normal style places 10 points of blank space after each paragraph and inserts a vertical 
space equal to 1.15 lines between each line of text. It also automatically adjusts line height 
to accommodate various font sizes and graphics.

The MLA documentation style requires that you double-space the entire research 
paper. That is, the amount of vertical space between each line of text and above and 
below paragraphs should be equal to one blank line. The next sets of steps adjust line 
spacing and paragraph spacing according to the MLA documentation style.

To Double-Space Text

To double-space the lines in the research paper, change the line spacing to 2.0. The following steps change 
line spacing to double.

Home tab
Line spacing 
button

Show/Hide ¶ 
button selected

line spacing to be 
changed to 2.0

check mark 
indicates current 
line spacing

displays a dialog box 
with additional line 
spacing options

Line spacing gallery 
displays list of line 
spacing options

zoom percent

Q
&

A
Q

&
A

Figure 2–2

1. Right-click paragraph, click 
Paragraph on shortcut 
menu, click Indents and 
Spacing tab, click Line 

spacing box arrow, click 
Double, click OK button

2. Click Paragraph Dialog 
Box Launcher, click Indents 

and Spacing tab, click Line 
spacing box arrow, click 
Double, click OK button

3. Press CTRL+2

Other Ways

Line Spacing
If the top of a set of 
characters or a graphical 
image is chopped off, 
then line spacing may be 
set to Exactly. To remedy 
the problem, change 
line spacing to 1.0, 1.15, 
1.5, 2.0, 2.5, 3.0 or At 
least (in the Paragraph 
dialog box), all of which 
accommodate the largest 
font or image.

B
T
W

insertion point

C6158_WRD_02.4c.indd   78C6158_WRD_02.4c.indd   78 3/6/07   3:08:48 PM3/6/07   3:08:48 PM



W
o

rd
 C

h
ap

te
r 

2Changing Document Settings   WD 79

To Remove Space after a Paragraph

The research paper should not have additional blank space after each paragraph. The following steps remove 
space after a paragraph.

once you select Remove 
Space After Paragraph, 
it changes to Add Space 
After Paragraph 

Line spacing 
gallery 

line spacing 
changed to double

1
• Click the Line spacing button on 

the Home tab to display the Line 
spacing gallery (Figure 2–3).

2
• Click Remove Space After 

Paragraph in the Line spacing 
gallery so that no blank space 
appears after a paragraph.

Can I remove space after existing 
paragraphs? 

Yes. Select the paragraphs fi rst and 
then remove the space as described 
in these steps.

Q
&

A

Figure 2–3

Other Ways

1. Click Spacing After 
box arrow on Page 
Layout tab until 0 pt is 
displayed

2. Right-click paragraph, 
click Paragraph on 
shortcut menu, click 
Indents and Spacing 
tab, click Spacing After 
box arrow until 0 pt 
is displayed, click OK 
button

3. Click Paragraph Dialog 
Box Launcher, click 
Indents and Spacing 
tab, click Spacing After 
box arrow until 0 pt 
is displayed, click OK 
button

Headers and Footers
A header is text and graphics that print at the top of each page in a document. Similarly, 

a footer is text and graphics that print at the bottom of every page. In Word, headers 
print in the top margin one-half inch from the top of every page, and footers print in the 
bottom margin one-half inch from the bottom of each page, which meets the MLA style. 
In addition to text and graphics, headers and footers can include document information 
such as the page number, current date, current time, and author’s name.

In this research paper, you are to precede the page number with your last name 
placed one-half inch from the upper-right edge of each page. The procedures on the 
following pages enter your name and the page number in the header, as specifi ed by the 
MLA style.

Line spacing 
button

insertion point
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2

I Experiment

• Click the down scroll 
arrow in the Header 
gallery to see the 
available built-in 
headers.

3
• Click the Edit Header 

command to switch 
from the document 
text to the header, 
which allows you to 
edit the contents of 
the header 
(Figure 2–5).

How do I remove the 
Header & Footer Tools and Design tabs from the Ribbon? 

When you are fi nished editing the header, you will close it, which removes the Header & 
Footer Tools tabs. 

To Switch to the Header

To enter text in the header, you instruct Word to edit the header. The following steps switch from editing the 
document text to editing the header.

1
• Click Insert on the 

Ribbon to display 
the Insert tab.

• Click the Header 
button on the Insert 
tab to display the 
Header gallery 
(Figure 2–4).

Can I use a built-in 
header for this 
research paper? 

None of the built-in 
headers adhere to 
the MLA style. Thus, 
you enter your own 
header contents, 
instead of using a 
built-in header, for 
this research paper. 

Bubble height
One line bubbles - 1p1
Two-line bubbles - 1p8
Three-line bubbles - 2p3
Four-line bubbles - 2p10

Insert tab
Header button

Edit Header command 
allows you to defi ne your 
own header contents

Remove Header command 
deletes header contents 
from entire document

clicking the down 
scroll arrow displays 
more built-in headers

list of built-in 
(predefi ned) headers

Header 
gallery

Bubble height
One line bubbles - 1p1
Two-line bubbles - 1p8
Three-line bubbles - 2p3
Four-line bubbles - 2p10

indicates header 
is being edited

bottom of 
header

document text is 
dim while you edit 
the header

paragraph 
left-aligned

Header & Footer Tools and 
Design tabs automatically 
appear because you are 
editing the header

header

Q
&

A
Q

&
A

Figure 2–4

Figure 2–5

Other Ways

1. Double-click dimmed 
header
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To Right-Align a Paragraph

The paragraph in the header currently is left-aligned (Figure 2–5). Your last name and the page number 
should print right-aligned, that is, at the right margin. The following steps right-align a paragraph.

1
• Click Home on the 

Ribbon to display 
the Home tab.

• Click the Align Text 
Right button on 
the Home tab to 
right-align the para-
graph in the header 
(Figure 2–6).

What if I wanted 
to return the 
paragraph to left-
aligned? 

Click the Align Text 
Right button again, 
or click the Align 
Text Left button.

Changing Document Settings   WD 81

Align Text 
Right button

paragraph 
right-aligned 
in header

Home tab

Header & Footer Tools and 
Design tabs remain on 
Ribbon because you still 
are editing the header

Figure 2–6

Q
&

A

Other Ways

1. Right-click paragraph, 
click Paragraph on 
shortcut menu, click 
Indents and Spacing 
tab, click Alignment 
box arrow, click Right, 
click OK button

2. Click Paragraph Dialog 
Box Launcher, click 
Indents and Spacing 
tab, click Alignment box 
arrow, click Right, click 
OK button

3. Press CTRL+R

To Enter Text

The following steps enter your last name right-aligned in the header area.

1  Click Design on the Ribbon to display the Design tab.

2  Type Pappas and then press the SPACEBAR to enter your last name in the header.

Footers
If you wanted to create 
a footer, you would click 
the Footer button on 
the Insert tab and then 
select the desired built-in 
footer or click Edit Footer 
to create a customized 
footer.

B
T
W
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To Insert a Page Number

The next task is to insert the current page number in the header. The following steps insert a page number at 
the location of the insertion point.

1
• Click the Insert Page 

Number button on 
the Design tab to 
display the Insert 
Page Number menu.

• Point to Current 
Position on the 
Insert Page Number 
menu to display the 
Current Position 
gallery (Figure 2–7).

Bubble height
One line bubbles - 1p1
Two-line bubbles - 1p8
Three-line bubbles - 2p3
Four-line bubbles - 2p10

Figure 2–7

Design tab

last name 
entered

Plain Number 
to be selected

Insert Page 
Number 
button

Current 
Position 
command

Insert Page 
Number menu

Current 
Position gallery

clicking the down scroll 
arrow displays more 
page number formats

2

I Experiment

• Click the down scroll arrow in the 
Current Position gallery to see the 
available page number formats.

3
• If necessary, scroll to the top of 

the Current Position gallery. Click 
Plain Number in the Current 
Position gallery to insert an 
unformatted page number at the 
location of the insertion point 
(Figure 2–8).

Figure 2–8

page number 
inserted at location 
of insertion point

Close Header and 
Footer button

insertion point

1. Click Insert Page Number 
button on Insert tab

2. Click Quick Parts button 
on Insert tab or on Design 

tab on Header & Footer Tools 
tab, click Field on Quick Parts 
menu, select Page in Field 
names list, click OK button

Other Ways
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To Close the Header

You are fi nished entering text in the header. Thus, the next task is to switch back to the document text. The 
following step closes the header.

1
• Click the Close Header and Footer 

button on the Design tab (shown 
in Figure 2–8) to close the header 
and switch back to the document 
text (Figure 2–9).

How do I make changes to existing 
header text? 

Switch to the header using the 
steps described on page WD 80, 
edit the header as you would edit 
text in the document window, 
and then switch back to the 
document text. 

Bubble height
One line bubbles - 1p1
Two-line bubbles - 1p8
Three-line bubbles - 2p3
Four-line bubbles - 2p10

Figure 2–9

Header & Footer Tools and 
Design tabs disappear from 
screen when you switch 
back to the document text

document text is 
bright when you 
switch back to the 
document text

header is dim when 
you switch back to 
the document text

Q
&

A

Other Ways

1. Double-click dimmed 
document text

Typing the Research Paper Text
The text of the research paper in this chapter encompasses the fi rst two pages of the paper. 
You will type the text of the research paper and then modify it later in the chapter, so that 
it matches Figure 2–1 on page WD 75.

Write the fi rst draft, referencing sources.
As you write the fi rst draft of your research paper, be sure it includes the proper components, 
uses credible sources, and does not contain any plagiarism. 

• Include an introduction, body, and conclusion. The fi rst paragraph of the paper introduces 
the topic and captures the reader’s attention. The body, which follows the introduction, 
consists of several paragraphs that support the topic. The conclusion summarizes the main 
points in the body and restates the topic.

• Evaluate sources for authority, currency, and accuracy. Be especially wary of information 
obtained from the Web. Any person, company, or organization can publish a Web page 
on the Internet. Ask yourself these questions about the source:

• Authority: Does a reputable institution or group support the source? Is the information 
presented without bias? Are the author’s credentials listed and verifi able?

• Currency: Is the information up to date? Are dates of sources listed? What is the last 
date revised or updated?

• Accuracy: Is the information free of errors? Is it verifi able? Are the sources clearly 
identifi ed?

• Acknowledge all sources of information; do not plagiarize. Not only is plagiarism 
unethical, but it is considered an academic crime that can have severe punishments such 
as failing a course or being expelled from school.

When you summarize, paraphrase (rewrite information in your own words), present 
facts, give statistics, quote exact words, or show a map, chart, or other graphical image, you 

(continued)

Plan 
Ahead
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As discussed earlier in this chapter, the MLA style does not require a separate title 
page for research papers. Instead, place your name and course information in a block at 
the top of the page, below the header, at the left margin.

To Enter Name and Course Information

1  Type Alex Pappas as the student name and then press the ENTER key.

2  Type Ms. Singh as the instructor name and then press the ENTER key.

3  Type English 104 as the course name and then press the ENTER key.

4  Type 28 March 2008 as the paper due date and then press the ENTER key (Figure 2–10).

Figure 2–10

student name 
entered on line 1

instructor name 
entered on line 2

course name 
entered on line 3

paper due date 
entered on line 4

insertion point

one blank line is 
displayed each time you 
press ENTER key because 
text is double-spaced

(continued)

must acknowledge the source. Information that commonly is known or accessible to the 
audience constitutes common knowledge and does not need to be acknowledged. If, 
however, you question whether certain information is common knowledge, you should 
document it — just to be safe. 

Plan 
Ahead

Date Formats
The MLA style prefers 
the day-month-year 
(28 March 2008) or 
month-day-year 
(March 28, 2008) format. 
Whichever format you 
select, use it consistently 
throughout the paper.

B
T
W
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1

I Experiment

• Move the mouse pointer around 
the document below the entered 
name and course information and 
observe the various icons that 
appear with the I-beam.

2
• Position the mouse pointer in 

the center of the document at 
the approximate location for the 
research paper title until a center 
icon appears below the I-beam 
(Figure 2–11).

What are the other icons that 
appear in the Click and Type 
pointer?

A left-align icon appears to the 
right of the I-beam when the 
Click and Type pointer is in certain 
locations on the left side of the 
document window. A right-align 
icon appears to the left of the icon 
when the Click and Type pointer is 
in certain locations on the right side 
of the document window.

Q
&

A

Figure 2–11

as you move the Click and 
Type pointer around the 
document below the entered 
name and course information, 
the icon changes to represent 
the formatting that will be 
applied if you double-click at 
that location

center icon

3
• Double-click to center the 

paragraph mark and insertion 
point between the left and 
right margins.

• Type Wireless Communications 
as the paper title and then press 
the ENTER key (Figure 2–12).

Figure 2–12

paragraph mark and 
insertion point are 
centered because 
formatting specifi ed in 
the previous paragraph 
carried forward when 
you pressed ENTER key

paper title centered 
between left and 
right margins

To Click and Type

The next step is to enter the title of the research paper centered between the page margins. In Chapter 1, you 
used the Center button on the Home tab to center text and graphics. As an alternative, you can use Click and Type to 
format and enter text, graphics, and other items. To use Click and Type, you double-click a blank area of the document 
window. Word automatically formats the item you enter according to the location where you just double-clicked. The 
next steps use Click and Type to center and then type the title of the research paper.
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Table 2–1 Shortcut Keys for Formatting Characters

Character Formatting Task Shortcut Keys Character Formatting Task Shortcut Keys

All capital letters CTRL+SHIFT+A Italic CTRL+I

Bold CTRL+B Remove character formatting (plain text) CTRL+SPACEBAR

Case of letters SHIFT+F3 Small uppercase letters CTRL+SHIFT+K

Decrease font size CTRL+SHIFT+< Subscript CTRL+EQUAL SIGN

Decrease font size 1 point CTRL+[ Superscript CTRL+SHIFT+PLUS SIGN

Double-underline CTRL+SHIFT+D Underline CTRL+U

Increase font size CTRL+SHIFT+> Underline words, not spaces CTRL+SHIFT+W

Increase font size 1 point CTRL+]

Shortcut Keys
Word has many shortcut keys for your convenience while typing. Table 2–1 lists the 

common shortcut keys for formatting characters. Table 2–2 lists common shortcut keys 
for formatting paragraphs.

Table 2–2 Shortcut Keys for Formatting Paragraphs

Paragraph Formatting Shortcut Keys Paragraph Formatting Shortcut Keys 

1.5 line spacing CTRL+5 Justify paragraph CTRL+J

Add/remove one line above paragraph CTRL+0 (ZERO) Left-align paragraph CTRL+L

Center paragraph CTRL+E Remove hanging indent CTRL+SHIFT+T

Decrease paragraph indent CTRL+SHIFT+M Remove paragraph formatting CTRL+Q

Double-space lines CTRL+2 Right-align paragraph CTRL+R

Hanging indent CTRL+T Single-space lines CTRL+1

Increase paragraph indent CTRL+M

To Format Text Using Shortcut Keys

The paragraphs below the paper title should be left-aligned, instead of centered. 
Thus, the next step is to left-align the paragraph below the paper title. When your fi ngers 
are already on the keyboard, you may prefer using shortcut keys, or keyboard key com-
binations, to format text as you type it. The following step left-aligns a paragraph using 
the shortcut keys CTRL+L. (Recall from Chapter 1 that a notation such as CTRL+L means 
to press the letter l on the keyboard while holding down the CTRL key.)

1  Press CTRL+L to left-align the current paragraph, that is, the paragraph containing the 
insertion point.

Why would I use a keyboard shortcut, instead of the Ribbon, to format text? 

Switching between the mouse and the keyboard takes time. If your hands are already on 
the keyboard, use a keyboard shortcut. If your hand is on the mouse, use the Ribbon. 

Q
&

A

Shortcut Keys
To print a complete list 
of shortcut keys in Word, 
click the Microsoft Offi ce 
Word Help button near 
the upper-right corner of 
the Word window, type 
shortcut keys in the 
‘Type words to search 
for’ text box at the top of 
the Word Help window, 
press the ENTER key, click 
the Keyboard shortcuts 
for Microsoft Offi ce Word 
link, click the Show All link 
in the upper-right corner 
of the Help window, click 
the Print button in the 
Help window, and then 
click the Print button in 
the Print dialog box.

B
T
W
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To Save a Document

You have performed many tasks while creating the research paper and do not want 
to risk losing the work completed thus far. Accordingly, you should save the document. For 
a detailed example of the procedure summarized below, refer to pages WD 19 through 
WD 21 in Chapter 1.

1  With a USB fl ash drive connected to one of the computer’s USB ports, click the Save button 
on the Quick Access Toolbar to display the Save As dialog box.

2  Type Wireless Communications Paper in the File name text box to change the fi le name.

3  Click the Save in box arrow and then click UDISK 2.0 (E:) in the Save in list to select the 
USB fl ash drive as the new save location. (Your USB fl ash drive may have a different 
name and letter.)

4  Click the Save button in the Save As dialog box to save the document on the USB fl ash 
drive with the fi le name, Wireless Communications Paper.

To Display the Rulers

According to the MLA style, the fi rst line of each paragraph in the research paper is to be indented one-half 
inch from the left margin. Although you can use a dialog box to indent paragraphs, Word provides a quicker way 
through the horizontal ruler. This ruler displays at the top edge of the document window just below the Ribbon. 
Word also provides a vertical ruler that displays along the left edge of the Word window. The following step 
displays the rulers. 

1

I Experiment

• Repeatedly click the 
View Ruler button 
on the vertical scroll 
bar to see the how 
this button is used to 
both show and hide 
the rulers. 

2
• If the rulers are not 

displayed, click the 
View Ruler button 
on the vertical scroll 
bar because you 
want to use the ruler 
to indent paragraphs 
(Figure 2–13).

Can I use the rulers 
for other tasks? 

In addition to indenting paragraphs, you can use the rulers to set tab stops, change page 
margins, and adjust column widths.

Q
&

A

Figure 2–13

View Ruler 
button

document saved with 
fi le name Wireless 
Communications Paper

ruler shows 
edge of top 
margin

ruler shows 
edge of left 
margin

ruler shows 
edge of right 
margin

vertical ruler

horizontal ruler

Other Ways

1. Click View Ruler check 
box on View tab

paragraph mark 
and insertion 
point left-aligned
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To First-Line Indent Paragraphs

The fi rst line of each paragraph in the research paper is to be indented one-half inch from the left margin. 
You can use the horizontal ruler, usually simply called the ruler, to indent just the fi rst line of a paragraph, called 
fi rst-line indent. 

The left margin on the ruler contains two triangles above a square. The First Line Indent marker is the 
top triangle at the 0” mark on the ruler (Figure 2–14). The bottom triangle is discussed later in this chapter. The 
small square at the 0” mark is the Left Indent marker. The Left Indent marker allows you to change the entire 
left margin, whereas the First Line Indent marker indents only the fi rst line of the paragraph. The following 
steps fi rst-line indent paragraphs in the research paper.

1
• With the insertion point on 

the paragraph mark below the 
research paper title, point to the 
First Line Indent marker on the 
ruler (Figure 2–14).

Figure 2–14

First Line 
Indent marker

insertion point

Left Indent 
Marker

2
• Drag the First Line Indent marker 

to the .5” mark on the ruler to 
display a vertical dotted line in 
the document window, which 
indicates the proposed location 
of the fi rst line of the paragraph 
(Figure 2–15).

COMP: Make sure arrows 
are pointing precisely where 
the Art MS indicates - they 
cannot even be slightly off

Figure 2–15

First Line Indent 
marker at .5” 
mark on ruler

as you drag marker on 
ruler, vertical dotted 
line indicates proposed 
location of indent
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3
• Release the mouse button to place 

the First Line Indent marker at the 
.5” mark on the ruler, or one-half 
inch from the left margin 
(Figure 2–16). 

Figure 2–16

paragraph mark 
containing insertion 
point indented one-
half inch

First Line Indent 
marker .5” from 
left margin

4
• Type Wireless 
communications are 

everywhere. People around 

the world regularly send 

and receive messages 

wirelessly, that is, 

transmitted through the 

air. and notice that Word 
automatically indented the 
fi rst line of the paragraph by 
one-half inch (Figure 2–17).

Will I have to set fi rst-line indent 
for each paragraph in the paper?

No. Each time you press the 
ENTER key, paragraph formatting 
in the previous paragraph carries 
forward to the next paragraph. 
Thus, once you set the fi rst-line 
indent, its format carries forward 
automatically to each subsequent 
paragraph you type.

Figure 2–17

fi rst line of 
paragraph indented 
one-half inch

fi rst two sentences 
in fi rst paragraph 
entered

Q
&

A
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1. Right-click paragraph, click 
Paragraph on shortcut 
menu, click Indents and 
Spacing tab, click Special box 
arrow, click First line, click 
OK button

2. Click Paragraph Dialog Box 
Launcher, click Indents and 
Spacing tab, click Special box 
arrow, click First line, click OK 
button

3. Press TAB key at beginning 
of paragraph

Other Ways
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To Create a Quick Style

Recall from Chapter 1 that a Quick Style is a predefi ned style that appears in the Styles gallery on the Ribbon. 
You use styles in the Styles gallery to apply defi ned formats to text. Later in this chapter, you will apply the formats 
of the research paper paragraph to the paragraphs in the footnote. To accomplish this task, you can create a Quick 
Style based on the formats in the current paragraph. That is, text is double-spaced with the fi rst line of the paragraph 
indented and no space after the paragraph. The following steps fi rst select the paragraph and then create a Quick 
Style based on the formats in the selected paragraph.

1
• Position the mouse pointer in the 

paragraph below the title and 
then triple-click; that is, press 
the mouse button three times 
in rapid succession, to select the 
paragraph.

• Right-click the selected paragraph 
to display a shortcut menu. 

• Point to Styles on the shortcut 
menu to display the Styles 
submenu (Figure 2–18).

Figure 2–18

shortcut 
menu

Styles 
submenu

paragraph 
selected

Styles 
command

Save Selection as a New 
Quick Style command

2
• Click Save Selection as a New 

Quick Style on the Styles sub-
menu to display the Create New 
Style from Formatting dialog box.

• Type Research Paper 
Paragraphs in the Name text 
box (Figure 2–19).

Bubble height
One line bubbles - 1p1
Two-line bubbles - 1p8
Three-line bubbles - 2p3
Four-line bubbles - 2p10

Figure 2–19

OK button

name of new Quick 
Style entered in 
Name text box

Create New Style from 
Formatting dialog box
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3
• Click the OK button to create the 

new Quick Style and add it to the 
Styles gallery (Figure 2–20).

How can I see the formats 
assigned to a Quick Style? 

Click the Styles Dialog Box Launcher. 
When the Styles task pane appears, 
position the mouse pointer on any 
style to display its formats. When 
fi nished, click the Close button in 
the task pane. 

Typing the Research Paper Text   WD 91

Figure 2–20

Research Paper 
Paragraphs Quick Style 
added to Styles gallery

Q
&

A

1. Click More button in Styles 
gallery on Home tab, click 
Save Selection as a New 

Quick Style, enter name 
of new Quick Style, click 
OK button

Other Ways

To AutoCorrect as You Type

As you type, you may make typing, spelling, capitalization, or grammar errors. For this reason, Word provides 
an AutoCorrect feature that automatically corrects these kinds of errors as you type them in the document. For 
example, if you type the text ahve, Word automatically changes it to the correct spelling, have, when you press the 
SPACEBAR or a punctuation mark key such as a period or comma.

Word has predefi ned many commonly misspelled words, which it automatically corrects for you. In the following 
steps, the word wireless is misspelled intentionally as wreless to illustrate the AutoCorrect as you type feature.

1
• Press CTRL+END to move the 

insertion point to the end of the 
document. 

• Press the SPACEBAR.

• Type the beginning of the next 
sentence, misspelling the word, 
wireless, as follows: Three types 
of wireless communications 

include wireless messaging 

services, wreless (Figure 2–21).

Figure 2–21

insertion point 
immediately follows 
last character in 
misspelled word

misspelled word

beginning of 
sentence entered

Styles Dialog Box 
Launcher
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Figure 2–22

rest of sentence 
entered

as soon as you press the 
SPACEBAR, Word detects 
the misspelling and corrects 
the misspelled word

2
• Press the SPACEBAR and watch 

how Word automatically corrects 
the misspelled word.

• Type the rest of the sentence 
(Figure 2–22): Internet access 
points, and global 

positioning systems.

To Use the AutoCorrect Options Button

When you position the mouse pointer on text that Word automatically corrected, a small blue box appears 
below the text. If you point to the small blue box, Word displays the AutoCorrect Options button. When you 
click the AutoCorrect Options button, Word displays a menu that allows you to undo a correction or change 
how Word handles future automatic corrections of this type. The following steps illustrate the AutoCorrect 
Options button and menu.

1
• Position the mouse pointer in 

the text automatically corrected 
by Word (in this case, the word 
wireless) to display a small blue 
box below the automatically 
corrected word (Figure 2–23).

Figure 2–23

clicking the small blue box 
will display the AutoCorrect 
Options button

mouse pointer is 
in automatically 
corrected text

2
• Point to the small blue box to 

display the AutoCorrect Options 
button.

• Click the AutoCorrect Options 
button to display the AutoCorrect 
Options menu (Figure 2–24). 

• Press the ESCAPE key to remove 
the AutoCorrect Options menu 
from the screen.

Do I need to remove the AutoCorrect 
Options button from the screen?

No. When you move the mouse pointer, the AutoCorrect Options button will disappear from 
the screen. If, for some reason, you wanted to remove the AutoCorrect Options button from 
the screen, you could press the ESCAPE key a second time.

Figure 2–24

AutoCorrect 
Options button

AutoCorrect 
Options menu

clicking this command 
will display the 
AutoCorrect dialog box

Q
&

A
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1
• Click the Offi ce Button 

to display the Offi ce 
Button menu 
(Figure 2–25).

To Create an AutoCorrect Entry

In addition to the predefi ned list of AutoCorrect spelling, capitalization, and grammar errors, you can create 
your own AutoCorrect entries to add to the list. For example, if you tend to type the word mobile as moble, you 
should create an AutoCorrect entry for it. The following steps create an AutoCorrect entry.

Figure 2–25

Word Options 
button

Offi ce Button Offi ce Button 
menu

Typing the Research Paper Text   WD 93

2
• Click the Word 

Options button 
on the Offi ce 
Button menu to 
display the Word 
Options dialog box.

• Click Proofi ng in the 
left pane to display 
proofi ng options in 
the right pane. 

• Click the AutoCorrect 
Options button in the 
right pane to display 
the AutoCorrect 
dialog box.

• When Word displays 
the AutoCorrect 
dialog box, type 
moble in the Replace 
text box.

• Press the TAB key and 
then type mobile 
in the With text box 
(Figure 2–26).

3
• Click the Add button in the AutoCorrect dialog box. (If your dialog box displays a Replace button 

instead, click it and then click the Yes button in the Microsoft Offi ce Word dialog box.) 

• Click the OK button to add the entry alphabetically to the list of words to correct automatically 
as you type.

• Click the OK button in the Word Options dialog box.

Figure 2–26

right pane displays 
options related to 
command selected 
in left pane

alphabetical list of 
currently defi ned 
AutoCorrect entries

Exceptions 
button

Word Options 
dialog box

AutoCorrect dialog box

left pane

misspelled word 
entered in Replace 
text box

AutoCorrect 
Options 
button

correct spelling entered 
in With text box

Proofi ng 
command

Add button

OK button

OK button
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The AutoCorrect Dialog Box
In addition to creating AutoCorrect entries for words you commonly misspell or 

mistype, you can create entries for abbreviations, codes, and so on. For example, you 
could create an AutoCorrect entry for asap, indicating that Word should replace this text 
with the phrase, as soon as possible.

If, for some reason, you do not want Word to correct automatically as you type, 
you can turn off the Replace text as you type feature by clicking the Word Options button 
on the Offi ce Button menu, clicking Proofi ng in the left pane of the Word Options dialog 
box, clicking the AutoCorrect Options button in the right pane of the Word Options 
dialog box (Figure 2–26 on the previous page), clicking the ‘Replace text as you type’ 
check box to remove the check mark, and then clicking the OK button in each open 
dialog box.

The AutoCorrect sheet in the AutoCorrect dialog box (Figure 2–26) contains other 
check boxes that correct capitalization errors if the check boxes are selected. If you type two 
capital letters in a row, such as TH, Word makes the second letter lowercase, Th. If you 
begin a sentence with a lowercase letter, Word capitalizes the fi rst letter of the sentence. If 
you type the name of a day in lowercase, such as tuesday, Word capitalizes the fi rst letter 
of the day, Tuesday. If you leave the CAPS LOCK key on and begin a new sentence, such as 
aFTER, Word corrects the typing, After, and turns off the CAPS LOCK key.

Sometimes you do not want Word to AutoCorrect a particular word or phrase. For 
example, you may use the code WD. in your documents. Because Word automatically 
capitalizes the fi rst letter of a sentence, the character you enter following the period will 
be capitalized (in the previous sentence, it would capitalize the letter i in the word, in). To 
allow the code WD. to be entered into a document and still leave the AutoCorrect feature 
turned on, you should set an exception. To set an exception to an AutoCorrect rule, click 
the Word Options button on the Offi ce Button menu, click Proofi ng in the left pane of the 
Word Options dialog box, click the AutoCorrect Options button in the right pane of the 
Word Options dialog box, click the Exceptions button (Figure 2–26), click the appropriate 
tab in the AutoCorrect Exceptions dialog box, type the exception entry in the text box, click 
the Add button, click the Close button in the AutoCorrect Exceptions dialog box, and then 
click the OK button in the remaining dialog boxes.

To Enter More Text

The next step is to continue typing text in the research paper up to the location of 
the citation.

1  Press the ENTER key, so that you can begin typing the text in the second paragraph.

2  Type People use mobile phones, PDAs, and other mobile devices to ac-
cess text messaging, instant messaging, and picture messaging servic-

es and then press the SPACEBAR.

Citations
Both the MLA and APA guidelines suggest the use of in-text parenthetical citations 

(placed at the end of a sentence), instead of footnoting each source of material in a paper. 
These parenthetical acknowledgments guide the reader to the end of the paper for complete 
information about the source.

Automatic Corrections
If you do not want to keep 
a change automatically 
made by Word and you 
immediately notice the 
automatic correction, 
you can undo the change 
by clicking the Undo 
button on the Quick 
Access Toolbar or pressing 
CTRL+Z. You also can undo 
a correction through the 
AutoCorrect Options 
button, which was shown 
on page WD 92.

B
T
W
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Reference all sources.
During your research, be sure to record essential publication information about each of your 
sources. Following is a sample list of types of required information.

• Book: full name of author(s), complete title of book, edition (if available), volume (if 
available), publication city, publication year

• Magazine: full name of author(s), complete title of article, magazine title, date of magazine, 
page numbers of article

• Web site: full name of author(s), title of Web site, date viewed, Web address

Plan 
Ahead

Typing the Research Paper Text   WD 95

Word provides tools to assist you with inserting citations in a paper and later generating 
a list of sources from the citations. With a documentation style selected, Word automatically 
formats the citations and list of sources. The process for adding citations in Word is as 
follows:

1. Modify the documentation style, if necessary.
2. Insert a citation placeholder.
3. Enter the source information for the citation.

You can combine Steps 2 and 3, where you insert the citation placeholder and enter 
the source information at once. Or, you can insert the citation placeholder as you write 
and then enter the source information for the citation at a later time. While entering the 
research paper in this chapter, you will use both methods.

To Change the Bibliography Style

The fi rst step in inserting a citation is to be sure the citations and sources will be formatted using the 
correct documentation style, called the bibliography style in Word. The following steps change the specifi ed 
documentation style.
1
• Click References on 

the Ribbon to 
display the 
References tab.

• Click the 
Bibliography Style 
box arrow on the 
References tab to 
display a gallery of 
predefi ned docu-
mentation styles 
(Figure 2–27).

2
• Click MLA in the 

Bibliography Style 
gallery to change 
the documentation 
style to MLA.

References tab

MLA to be 
selected

Bibliography 
Style box arrow

gallery of 
predefi ned 
documentation 
styles

insertion 
point

paragraph mark 
indicates ENTER 
key was pressed

fi rst line of subsequent 
paragraph indented 
automatically when 
you pressed ENTER key

Figure 2–27

fi rst part of 
sentence 
entered
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To Insert a Citation and Create Its Source

With the documentation style selected, the next task is to insert a citation placeholder and enter the source 
information. You can accomplish these steps at once by instructing Word to add a new source. The following steps 
add a new source for a magazine (periodical) article.

1
• Click the Insert Citation button 

on the References tab to display 
the Insert Citation menu 
(Figure 2–28).

Add New Source 
command

Insert Citation 
button

style changed 
to MLA

Insert Citation 
menu

Figure 2–28
2
• Click Add New Source on the 

Insert Citation menu to display 
the Create Source dialog box 
(Figure 2–29).

What are the Bibliography Fields 
in the Create Source dialog box?

A fi eld is a placeholder for 
data whose contents can 
change. You enter data in 
some fi elds; Word supplies 
data for others. In this case, 
you enter the contents of the 
fi elds for a particular source, for 
example, the author name in the 
Author fi eld.

I Experiment

• Click the Type of Source box 
arrow and then click one of the 
source types in the list, so that 
you can see how the list of fi elds 
changes to refl ect the source type 
you selected. 

Figure 2–29

Type of Source 
box arrow

Create Source 
dialog box

source displayed in Type of 
Source box controls which 
fi elds are displayed in dialog 
box — your source may differ

list of Bibliography Fields 
changes, depending on 
the source selected in the 
Type of Source box

Q
&
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3
• If necessary, click the Type of 

Source box arrow and then click 
Article in a Periodical, so that the 
list shows fi elds required for a 
magazine (periodical).

• Click the Author text box. Type 
Davies, Habika as the author.

• Click the Title text box. Type 
Text Messaging, Instant 

Messaging, and Picture 

Messaging as the article title.

• Press the TAB key and then type 
Computing in Today’s World 
as the periodical title.

• Press the TAB key and then type 
2008 as the year.

• Press the TAB key and then type 
January as the month.

• Press the TAB key twice and 
then type 34-42 as the pages 
(Figure 2–30).

Figure 2–30

OK button

Type of Source 
box arrow

source changed 
to Article in a 
Periodical

source 
information 
entered in 
text boxes

list changed to 
refl ect fi elds 
required for a 
periodical

4
• Click the OK button to close the 

dialog box, create the source, and 
insert the citation in the document 
at the location of the insertion 
point (Figure 2–31).

insertion point

citation inserted 
in text

Figure 2–31
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To Edit a Citation

In the MLA style, if a source has page numbers, you should include them in the citation. Thus, Word provides 
a means to enter the page numbers to be displayed in the citation. The following steps edit a citation, so that the 
page numbers appear in it.

1
• Click somewhere in the citation to 

be edited, in this case somewhere 
in (Davies), to select the citation 
and display the Citation Options 
box arrow.

• Click the Citation Options box 
arrow to display the Citation 
Options menu (Figure 2–32).

What is the purpose of the tab to 
the left of the selected citation? 

If, for some reason, you wanted to 
move a citation to a different loca-
tion in the document, you would 
select it and then drag the citation 
tab to the desired location. 

Citation Options 
box arrow

Edit Citation 
command to be 
selected

Citation 
Options menu

citation tab is used to 
move a citation to a 
different location in 
the document

Figure 2–32
2
• Click Edit Citation on the Citation 

Options menu to display the Edit 
Citation dialog box.

• Type 34-42 in the Pages text box 
(Figure 2–33).

OK button

pages 
entered

Edit Citation 
dialog box

Figure 2–33

3
• Click the OK button to close the 

dialog box and add the page 
numbers to the citation in the 
document (Figure 2–34).

4
• Press the END key to move the 

insertion point to the end of 
the line, which also deselects the 
citation.

• Press the PERIOD key to end the 
sentence.

page numbers 
added to citation

citation remains 
selected

Figure 2–34

Q
&
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citation 
selected 
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To Enter More Text

The next step is to continue typing text in the research paper up to the location of 
the footnote.

1  Press the SPACEBAR.

2  Type these three sentences (Figure 2–35): Through text messaging services, users 
send and receive short text messages, which usually consist of fewer 

than 300 characters. Wireless instant messaging is an Internet 

communications service that allows a wireless mobile device to 

exchange instant messages with one or more mobile devices or online 

personal computers. Users send graphics, pictures, video clips, sound 

fi les, and short text messages with picture messaging services.

Figure 2–35

insertion 
point

citation complete 
with page 
numbers

sentences 
entered

Footnotes
As discussed earlier in this chapter, explanatory notes are optional in the MLA 

documentation style. They are used primarily to elaborate on points discussed in the body 
of a research paper. The MLA style specifi es that a superscript (raised number) be used for 
a note reference mark to signal that an explanatory note exists either at the bottom of 
the page as a footnote or at the end of the document as an endnote.

In Word, note text can be any length and format. Word automatically numbers 
notes sequentially by placing a note reference mark in the body of the document and also 
to the left of the note text. If you insert, rearrange, or remove notes, Word renumbers any 
subsequent note reference marks according to their new sequence in the document.

Edit a Source
To edit a source, click 
somewhere in the 
citation, click the Citation 
Options box arrow, and 
then click Edit Source 
on the Citation Options 
menu to display the Edit 
Source dialog box (which 
resembles the Create 
Source dialog box). Make 
necessary changes and 
then click the OK button.

B
T
W

C6158_WRD_02.4c.indd   99C6158_WRD_02.4c.indd   99 3/6/07   3:09:33 PM3/6/07   3:09:33 PM



WD 100   Word Chapter 2   Creating a Research Paper

To Insert a Footnote Reference Mark

The following step inserts a footnote reference mark in the document at the location of the insertion point 
and also at the location where the footnote text will be typed.

1
• With the insertion 

point positioned 
as shown in 
Figure 2–35 on 
the previous page, 
click the Insert 
Footnote button on 
the References tab 
to display a note 
reference mark (a 
superscripted 1) in 
two places: (1) in the 
document window 
at the location of the 
insertion point and 
(2) at the bottom of 
the page where the 
footnote will be 
positioned, just 
below a separator 
line (Figure 2–36). 

What if I wanted 
explanatory notes 
to be positioned as 
endnotes instead of 
as footnotes? 

You would click 
the Insert Endnote 
button on the 
References tab, 
which places the 
separator line and 
the endnote text 
at the end of the 
document, instead of the 
bottom of the page containing the reference. 

Figure 2–36

Insert 
Footnote 
button

References tab

footnote text will 
be typed here separator line, which automatically is inserted, 

divides document text from note text

note reference mark is 
displayed, by default, 
superscripted in document 
window and in note text area

Other Ways

1. Press CTRL+ALT+F

To Enter Footnote Text

The next step is to type the footnote text to the right of the note reference mark 
below the separator line.

1  Type the footnote text up to the citation: Podpora and Ruiz indicate that some 
messaging services use the term, video messaging, to refer separately 

to the capability of sending video clips and then press the SPACEBAR.

Q
&

A

Insert Endnote 
button
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2
• Click Add New Placeholder on the 

Insert Citation menu to display the 
Placeholder Name dialog box.

• Type Podpora as the tag name for 
the source (Figure 2–38).

What is a tag name? 

A tag name is an identifi er that 
links a citation to a source. Word 
automatically creates a tag name 
when you enter a source. When 
you create a citation placeholder, 
enter a meaningful tag name, 
which will appear in the citation 
placeholder until you edit the 
source. 

3
• Click the OK button to close the 

dialog box and insert the tag 
name in the citation placeholder.

• Press the PERIOD key to end the 
sentence.

To Insert a Citation Placeholder

Earlier in this chapter, you inserted a citation and its source at once. Sometimes, you may not have the source 
information readily available and would prefer entering it at a later time. 

In the footnote, you will insert a placeholder for the citation and enter the source information later. The 
following steps insert a citation placeholder.

1
• With the insertion point 

positioned as shown in 
Figure 2–37, click the Insert 
Citation button on the References 
tab to display the Insert Citation 
menu (Figure 2–37).

Add New 
Placeholder 
command

Insert 
Citation 
button

footnote text 
entered

insertion point

Insert Citation menu 
includes previously 
inserted source

Figure 2–37

OK button

tag name entered

Placeholder Name 
dialog box

Figure 2–38

Q
&

A
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Footnote Text Style
When you insert a footnote, Word formats it using the Footnote Text style, which 

does not adhere to the MLA documentation style. For example, notice in Figure 2–38 on 
the previous page that the footnote text is single-spaced, left-aligned, and a smaller font 
size than the text in the research paper. According to the MLA style, notes should be 
formatted like all other paragraphs in the paper.

You could change the paragraph formatting of the footnote text to fi rst-line indent 
and double-spacing and then change the font size from 10 to 11 point. If you use this tech-
nique, however, you will need to change the format of the footnote text for each footnote 
you enter into the document.

A more effi cient technique is to modify the format of the Footnote Text style so that 
every footnote you enter into the document will use the formats defi ned in this style. 

To Modify a Style Using a Shortcut Menu

The Footnote Text style should be based on the Research Paper Paragraphs style defi ned earlier in this chapter. 
Because the Footnote Text style specifi cally set paragraphs to single-spaced and the font size to 10 point, you will need 
to modify those formats to double-spaced paragraphs and 11-point font. The following steps modify the Footnote 
Text style.

1
• Right-click the note text in the 

footnote to display a shortcut 
menu related to footnotes 
(Figure 2–39).

Style 
command

shortcut menu

insertion 
point

citation 
placeholder 
inserted

footnote paragraphs should be 
formatted the same as other 
paragraphs in the research paper

Figure 2–39
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3
• Click the OK button in the 

Modify Style dialog box to close 
the dialog box.

• Click the Apply button in the 
Style dialog box to apply the style 
changes to the footnote text 
(Figure 2–41).

Will all footnotes use this 
modifi ed style?

Yes. Any future footnotes entered 
into the document will use an 11-point 
font with the paragraphs fi rst-line indented and double-spaced. 

2
• Click Style on the 

shortcut menu to dis-
play the Style dialog 
box. If necessary, 
click Footnote 
Text in the 
Styles list.

• Click the Modify 
button in the 
Style dialog box 
to display the Modify 
Style dialog box.

• Click the ‘Style based 
on’ box arrow and 
then click Research 
Paper Paragraphs so 
that the Footnote 
Text style is based on 
the Research Paper 
Paragraphs style. 

• Click the ‘Style for 
following paragraph’ 
box arrow and then 
scroll to and click 
Research Paper 
Paragraphs so that 
the additional footnote 
paragraphs are based on the Research Paper Paragraphs style.

• Click the Font Size box arrow and then click 11 in the Font Size list to change the font size to 11.

• Click the Double Space button to set the line spacing to double (Figure 2–40).

OK button

Apply button

Font Size 
box arrow Double Space 

button

Style based on 
box arrow

Style for 
following 
paragraph 
box arrow

Styles list

Style dialog box

Modify Style 
dialog box

Footnote 
Text style 
selected

Preview area 
lists formats 
assigned to 
selected style

Figure 2–40

Footnote Text style 
modifi ed to match 
research paper 
paragraphs

Figure 2–41

1. Click Styles Dialog Box 
Launcher, click Footnote Text 
in list, click Footnote Text 
box arrow, click Modify, 

 change settings, click OK 
button

2. Click Styles Dialog Box 
Launcher, click Manage Styles 

button, scroll to Footnote Text 
and then select it, click Modify 
button, change settings, click 
OK button in each dialog box

Other Ways

Q
&

A

Modify 
button
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To Edit a Source

When you typed the footnote text for this research paper, you inserted a citation placeholder for the source. 
You now have the source information and are ready to enter it. The following steps edit the source.

1
• Click somewhere in the citation 

placeholder to be edited, in this 
case (Podpora), to select the 
citation placeholder.

• Click the Citation Options box 
arrow to display the Citation 
Options menu (Figure 2–42).

Figure 2–42

Type of Source 
box arrow

source 
information 
entered in 
text boxes

OK button

Figure 2–43

Citation 
Options menu

Edit Source 
command

Citation Options 
box arrow

Other Ways

1. Click Manage Sources 
button on References 
tab, click placeholder 
source in Current List, 
click Edit button

2
• Click Edit Source on the Citation 

Options menu to display the Edit 
Source dialog box.

• If necessary, click the Type of 
Source box arrow and then click 
Book, so that the list shows fi elds 
required for a book.

• Click the Author text box. Type 
Podpora, Maxine C., and 

Adelbert D. Ruiz as the author.

• Click the Title text box. Type 
Advances in Wireless 

Internet Access Point 

Technology as the book title.

• Press the TAB key and then type 
2008 as the year.

• Press the TAB key and then type 
Dallas as the city.

• Press the TAB key and then type 
Wells Publishing as the 
publisher (Figure 2–43).

3

• Click the OK button to close the 
dialog box and create the source.

citation placeholder 
selected

Edit Source 
dialog box
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To Edit a Citation

In the MLA style, if you reference the author’s name in the text, you should not list 
it again in the parenthetical citation. Instead, just list the page number in the citation. The 
following steps edit the citation, suppressing the author but displaying the page numbers.

1  If necessary, click somewhere in the citation to be edited, in this case (Podpora), to select 
the citation and display the Citation Options box arrow.

2  Click the Citation Options box arrow to display the Citation Options menu.

3  Click Edit Citation on the Citation Options menu to display the Edit Citation dialog box.

4  Type 79-82 in the Pages text box.

5  Click the Author check box to place a check mark in it (Figure 2–44).

6  Click the OK button to close the dialog box, remove the author name from the citation in 
the footnote, and add page numbers to the citation.

OK button

pages 
entered

check box selected 
so that author 
name does not 
appear in citation

citation 
selected

Edit Citation 
dialog box

Figure 2–44

Citation 
Options 
box arrow
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Working with Footnotes and Endnotes
You edit footnote text just as you edit any other text in the document. To delete or 

move a note reference mark, however, you must be in the document text (not in the foot-
note text). 

To delete a note, select the note reference mark in the document text (not in the 
footnote text) by dragging through the note reference mark and then click the Cut but-
ton on the Home tab. Another way to delete a note is to click immediately to the right of 
the note reference mark in the document text and then press the BACKSPACE key twice, or 
to click immediately to the left of the note reference mark in the document text and then 
press the DELETE key twice.

To move a note to a different location in a document, select the note reference mark 
in the document text (not in the footnote text), click the Cut button on the Home tab, click 
the location where you want to move the note, and then click the Paste button on the Home 
tab. When you move or delete notes, Word automatically renumbers any remaining notes in 
the correct sequence.

If you position the mouse pointer on the note reference mark, the note text displays 
above the note reference mark as a ScreenTip. To remove the ScreenTip, move the mouse 
pointer.

If, for some reason, you wanted to change the format of note reference marks in 
footnotes or endnotes (i.e., from 1, 2, 3, to A, B, C), you would click the Footnotes Dialog 
Box Launcher to display the Footnote and Endnote dialog box, click the Number format 
box arrow, click the desired number format in the list, and then click the OK button.

If, for some reason, you wanted to convert footnotes to endnotes, you would click 
the Footnotes Dialog Box Launcher to display the Footnote and Endnote dialog box, 
click the Convert button, make sure the Convert all footnotes to endnotes option button is 
selected, click the OK button, and then click the Close button in the Footnote and Endnote 
dialog box.

To Enter More Text

The next step is to continue typing text in the body of the research paper.

1  Position the insertion point after the note reference mark in the document, and then press 
the ENTER key.

2  Type the third paragraph of the research paper (Figure 2–45): In many public 
locations, people connect to the Internet through a wireless Internet 

access point using mobile computers and devices. Two types of wireless 

Internet access points are hot spots and 3-G networks. A 3-G network, 

which uses cellular radio technology, enables users to connect to the 

Internet through a mobile phone or computer equipped with an 

appropriate PC Card. A hot spot is a wireless network that allows 

mobile users to check e-mail, browse the Web, and access any Internet 

service - as long as their computers or devices have the proper 

wireless capability.

Spacing after 
Punctuation
Because word processing 
documents use variable 
character fonts, it often is 
diffi cult to determine in 
a printed document how 
many times someone 
has pressed the SPACEBAR 
between sentences. 
The rule is to press the 
SPACEBAR only once after 
periods, colons, and 
other punctuation marks.

B
T
W

C6158_WRD_02.4c.indd   106C6158_WRD_02.4c.indd   106 3/6/07   3:09:46 PM3/6/07   3:09:46 PM



W
o

rd
 C

h
ap

te
r 

2Typing the Research Paper Text   WD 107

To Count Words

Often when you write papers, you are required to compose the papers with a minimum number of words. The 
minimum requirement for the research paper in this chapter is 325 words. You can look on the status bar and see the 
total number of words thus far in a document. For example, Figure 2–45 shows the research paper has 250 words, 
but you are not sure if that count includes the words in your footnote. The following steps display the Word Count 
dialog box, so that you can verify whether the footnote text is included in the count.

1
• Click the Word 

Count indicator on 
the status bar to dis-
play the Word Count 
dialog box.

• If necessary, place a 
check mark in the 
‘Include textboxes, 
footnotes and 
endnotes’ check box.

Why do the statistics 
in my Word Count 
dialog box differ 
from Figure 2–45? 

Depending on the 
accuracy of your 
typing, your statistics 
may differ. 

2
• Click the Close 

button to close the 
dialog box.

Can I display 
statistics for just 
a section of the 
document?

Yes. Select the 
section and then 
click the Word Count 
indicator on the status bar to display statistics about the selected text. 

Other Ways

1. Click Word Count 
button on Review tab

2. Press CTRL+SHIFT+G

Figure 2–45

be sure check 
box is selected

Word Count 
indicator shows 
current word 
count is 250

insertion 
point

Word Count 
dialog box

statistics 
about current 
document

paragraph 
entered

Close button

Automatic Page Breaks
As you type documents that exceed one page, Word automatically inserts page 

breaks, called automatic page breaks or soft page breaks, when it determines the text 
has fi lled one page according to paper size, margin settings, line spacing, and other set-
tings. If you add text, delete text, or modify text on a page, Word recomputes the location 
of automatic page breaks and adjusts them accordingly.

Word performs page recomputation between the keystrokes, that is, in between the 
pauses in your typing. Thus, Word refers to the automatic page break task as background 
repagination. The steps on the next page illustrate Word’s automatic page break feature.

Q
&

A
Q

&
A

ENTER key 
pressed after note 
reference mark

author name removed 
from citation and 
page numbers added
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To Enter More Text and Insert a Citation Placeholder

The next task is to type the fourth paragraph in the body of the research paper.

1  With the insertion point positioned at the end of the third paragraph as shown in 
Figure 2–45 on the previous page, press the ENTER key. Type the fourth paragraph of the research 
paper (Figure 2–46): A global positioning system (GPS) is a navigation system 
that consists of one or more earth-based receivers that accept and analyze 

signals sent by satellites in order to determine the receiver’s geographic 

location, according to Shelly and Cashman and then press the SPACEBAR.

2  Click the Insert Citation button on the References tab to display the Insert Citation menu.
Click Add New Placeholder on the Insert Citation menu to display the Placeholder Name 
dialog box.

3  Type Shelly as the tag name for the source.

4  Click the OK button to close the dialog box and insert the tag name in the citation 
placeholder.

5  Press the PERIOD key to end the sentence. Press the SPACEBAR. Type A GPS receiver is 
a handheld, mountable, or embedded device that contains an antenna, a 

radio receiver, and a processor. Many mobile devices, such as mobile 

phones and PDAs, have GPS capability built into the device.

6  Press the ENTER key.

Figure 2–46

placeholder 
citation entered

word count now 
meets minimum 
required

correct page 
number 
automatically 
appears in header

footnote remains 
at bottom of 
fi rst page

page break

insertion 
point now 
on page 2

entered 
paragraph 
spans two pages

Page Break Locations
As you type, your 
page break may occur 
at different locations 
depending on Word 
settings and the type of 
printer connected to the 
computer.

B
T
W
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To Edit a Source

When you typed the fourth paragraph of the research paper, you inserted a citation 
placeholder, Shelly, for the source. You now have the source information, which is for a 
Web site, and are ready to enter it. The following steps edit the source for the Shelly 
citation placeholder.

1  Click somewhere in the citation placeholder to be edited, in this case (Shelly), to select the 
citation placeholder.

2  Click the Citation Options box arrow to display the Citation Options menu.

3  Click Edit Source on the Citation Options menu to display the Edit Source dialog box.

4  If necessary, click the Type of Source box arrow, scroll to and then click Web site, so that 
the list shows fi elds required for a Web site.

5  Place a check mark in the Show All Bibliography Fields check box to display more fi elds 
related to Web sites.

6  Click the Author text box. Type Shelly, Gary B., and Thomas J. Cashman as 
the author.

7  Click the Name of Web Page text box. Type How a GPS Works as the Web page title.

8  Click the Production Company text box. Type Course Technology as the production 
company.

9  Click the Year Accessed text box. Type 2008 as the year.

10  Press the TAB key and then type March as the month accessed.

What if some of the text boxes disappear as I enter the Web site fi elds?

With the Show All Bibliography Fields check box selected, all Web site fi elds may not be 
able to be displayed in the dialog box at the same time. In this case, some may scroll up. 

11  Press the TAB key 
and then type 21 as 
the day accessed.

12  Press the TAB key and then type 
www.scsite.com/wd2007/

pr2/wc.htm as the URL 
(Figure 2–47).

13  Click the OK button to close 
the dialog box and create 
the source.

Q
&

A

Figure 2–47

OK button

Citation Options 
box arrow

Type of Source 
box arrow

citation 
placeholder 
selected

Show All 
Bibliography 
Fields check 
box is selected

Edit Source 
dialog box

displayed fi elds 
relate to Web 
site sources
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To Edit a Citation

As mentioned earlier, if you reference the author’s name in the text, you should not 
list it again in the parenthetical citation. For Web site citations, when you suppress the 
author’s name, the citation shows the Web site name because page numbers do not apply. 
The following steps edit the citation, suppressing the author and displaying the name of 
the Web site.

1  If necessary, click the somewhere in citation to be edited, in this case (Shelly), to select the 
citation and display the Citation Options box arrow.

2  Click the Citation Options box arrow and then click Edit Citation on the Citation Options 
menu to display the Edit Citation dialog box.

3  Click the Author check box to place a check mark in it (Figure 2–48).

4  Click the OK button to close the dialog box, remove the author name from the citation, 
and show the name of the Web site in the citation.

OK button

Author check 
box selected

Citation 
Options 
box arrow

Edit Citation 
dialog box

last paragraph 
will be 
entered here

Figure 2–48

citation 
selected
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To Enter More Text

The next step is to type the last paragraph of text in the research paper.

1  Position the 
insertion point 
on the paragraph 
mark below the 
fourth paragraph in 
the research paper 
(Figure 2–48).

2  Type the last 
paragraph of the 
research paper 
(Figure 2–49): 
Mobile users 

communicate 

wirelessly 

through 

wireless 

messaging services, wireless Internet access points, and global 

positioning systems. Anyone can take advantage of wireless communications 

using mobile computers and devices.

To Save an Existing Document with the Same File Name

You have made several edits to the research paper since you last saved it. Thus, you 
should save it again. The following step saves the document again.

1  Click the Save button on the Quick Access Toolbar to overwrite the previous Wireless 
Communications Paper fi le on the USB fl ash drive.

Creating an Alphabetical Works Cited Page
According to the MLA style, the works cited page is a list of sources that are referenced 
directly in a research paper. You place the list on a separate numbered page with the title, 
Works Cited, centered one inch from the top margin. The works are to be alphabetized 
by the author’s last name or, if the work has no author, by the work’s title. The fi rst line of 
each entry begins at the left margin. Indent subsequent lines of the same entry one-half 
inch from the left margin.

Figure 2–49

citation shows 
name of Web site

last 
paragraph 
entered

Create the list of sources.
A bibliography is an alphabetical list of sources referenced in a paper. Whereas the text of 
the research paper contains brief references to the source (the citations), the bibliography 
lists all publication information about the source. Documentation styles differ signifi cantly 
in their guidelines for preparing a bibliography. Each style identifi es formats for various 
sources including books, magazines, pamphlets, newspapers, Web sites, television programs, 
paintings, maps, advertisements, letters, memos, and much more. You can fi nd information 
about various styles and their guidelines in printed style guides and on the Web.

Plan 
Ahead
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To Page Break Manually

The works cited are to be displayed on a separate numbered page. Thus, you must insert a manual page break 
following the body of the research paper so that the list of sources is displayed on a separate page. A manual page 
break, or hard page break, is one that you force into the document at a specifi c location. 

Word never moves or adjusts manual page breaks; however, Word adjusts any automatic page breaks that fol-
low a manual page break. Word inserts manual page breaks immediately above the location of the insertion point. 
The following step inserts a manual page break after the text of the research paper.

1
• With the insertion point at the 

end of the text of the research 
paper, press the ENTER key.

• Then, press CTRL+ENTER to insert a 
manual page break immediately 
above the insertion point and 
position the insertion point 
immediately below the manual 
page break (Figure 2–50).

• Scroll to position the top of the 
third page closer to the ruler.

Figure 2–50

bottom of 
page 2

page break

correct page 
number 
automatically 
appears in header

insertion 
point on 
page 3

Other Ways

1. Click Page Break button 
on Insert tab

To Center the Title of the Works Cited Page

The works cited title is to be centered between the margins of the paper. If you simply 
issue the Center command, the title will not be centered properly. Instead, it will be one-half 
inch to the right of the center point because earlier you set fi rst-line indent at one-half inch. 
Recall that Word is indenting the fi rst line of every paragraph one-half inch.

To properly center the title of the works cited page, you must move the First Line 
Indent marker back to the left margin before centering the paragraph.

Figure 2–51

title centered 
and typed

First Line Indent 
marker moved to 
left margin

right margin

insertion 
point

1   Drag the First Line 
Indent marker to the 
0” mark on the ruler, 
which is at the left 
margin, to remove 
the fi rst-line indent 
setting.

2   Press CTRL+E to 
center the 
paragraph mark.

3   Type Works Cited 
as the title.

4   Press the ENTER key.

5   Press CTRL+L to 
left-align the paragraph 
mark (Figure 2–51).
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To Create the Bibliographical List

While typing the research paper, you created several citations and their sources. Word can format the list of 
sources and alphabetize them in a bibliographical list, saving you time looking up style guidelines. That is, Word 
will create a bibliographical list with each element of the source placed in its correct position with proper format-
ting and punctuation, according to the specifi ed style. For example, in this research paper, the book source will list, 
in this order, the author name(s), book title, publisher city, publishing company name, and publication year with the 
book title underlined and the correct punctuation between each element according to the MLA style. The following 
steps create a MLA formatted bibliographical list from the sources previously entered.

1
• With the insertion point 

positioned as shown in 
Figure 2–52, click the Bibliography 
button on the References tab to 
display the Bibliography gallery 
(Figure 2–52).

Will I select Works Cited from the 
Bibliography gallery?

No. The title it inserts is not 
formatted according to the MLA 
style. Thus, you will use the Insert 
Bibliography command instead. 

Bibliography 
button

Insert 
Bibliography 
command

insertion 
point

Bibliography 
gallery

Figure 2–52

Q
&

A
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2
• Click Insert Bibliography in the 

Bibliography gallery to insert a list 
of sources at the location of the 
insertion point.

• If necessary, scroll to 
display the entire list 
of sources in the 
document window 
(Figure 2–53).

Figure 2–53

alphabetical 
list of sources 
automatically 
generated by Word
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To Modify a Style Using the Styles Task Pane

Although the format within each entry in the bibliographical list meets the MLA style, the paragraph formatting 
does not. Currently, entries are based on the Normal style, which does not have the correct line or paragraph spacing. 
Thus, you will modify the style so that it is based on the No Spacing style (no blank space before or after a paragraph) 
and change its line spacing to double. The following steps modify the Bibliography style.

1
• Click somewhere in 

the list of sources to 
position the insertion 
point in a paragraph 
formatted with the 
Bibliography style.

Why did the list of 
sources turn gray? 

The entire list of 
sources is a fi eld that 
Word automatically 
updates each time 
you make a change 
to one of the sources. 
Word, by default, 
shades fi elds gray on 
the screen to help 
you identify them. 
The gray shading, 
however, will not 
appear in the printed 
document.

• Click Home on the 
Ribbon to display the 
Home tab.

• Click the Styles 
Dialog Box Launcher  
to display the Styles 
task pane. 

• If necessary, scroll to 
Bibliography in the 
Styles task pane. Click 
Bibliography to select it, 
if necessary, and then click its box arrow to display the Bibliography menu (Figure 2–54).

Home tab

insertion point

Bibliography 
box arrow

Styles Dialog 
Box Launcher

Bibliography 
selected

Modify 
command

Styles 
task pane

Bibliography 
menu

Word shades fi elds 
gray when the 
insertion point is 
in the fi eld

Figure 2–54

Q
&

A

Home tab
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2
• Click the Modify 

command on the 
Bibliography menu 
to display the Modify 
Style dialog box.

• Click the ‘Style 
based on’ box arrow 
and then click No 
Spacing to base the 
Bibliography style on 
the No Spacing style. 

• Click the ‘Style for 
following paragraph’ 
box arrow and then 
click No Spacing 
to base additional 
bibliographical para-
graphs on the No 
Spacing style.

• Click the Double Space 
button to set the line 
spacing to double.

• Place a check mark 
in the Automatically 
update check box 
so that any future 
changes you make to 
the bibliographical 
paragraphs will update the Bibliography style automatically (Figure 2–55).

OK button

Style based 
on box arrow

Styles task pane 
Close button

Double Space 
button

Automatically 
update check 
box selected

Style for 
following 
paragraph 
box arrow

Modify Style 
dialog box

preview of 
modifi ed style

Figure 2–55

3
• Click the OK button in the Modify 

Style dialog box to close the dialog 
box and apply the style changes 
to the paragraphs in the 
document.

• Click the Close button on 
the Styles task pane title 
bar to close the task pane 
(Figure 2–56).

Figure 2–56

style of 
paragraphs 
changed

Other Ways

1. Click Styles Dialog Box 
Launcher, click Manage 
Styles button, scroll to 
style and then select 
it, click Modify button, 
change settings, click 
OK button in each 
dialog box
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To Create a Hanging Indent

Currently, the fi rst line of each source entry begins at the left margin. Subsequent lines in the same paragraph 
are to be indented one-half inch from the left margin. In essence, the fi rst line hangs to the left of the rest of the 
paragraph; thus, this type of paragraph formatting is called a hanging indent.

One method of creating a hanging indent is to use the horizontal ruler. The Hanging Indent marker is the 
bottom triangle at the 0” mark on the ruler (Figure 2–57). The following steps create a hanging indent using the 
horizontal ruler.

1
• With the insertion point in the 

paragraph to format, point to the 
Hanging Indent marker on the 
ruler (Figure 2–57).

Hanging Indent marker

insertion point

Figure 2–57

2
• Drag the Hanging Indent marker 

to the .5” mark on the ruler to set 
the hanging indent to one-half 
inch from the left margin 
(Figure 2–58).

Why were all three bibliographical 
paragraphs formatted with a 
hanging indent? 

When you make a change to 
a paragraph based on the 
Bibliography style, the 
style is updated and all 
paragraphs based on 
that style also change 
because you selected 
the Automatically 
update check box in the Modify 
Style dialog box (shown in 
Figure 2–55 on the previous page).

Figure 2–58

Hanging Indent 
marker positioned 
.5” from left margin

First Line Indent 
marker remains 
at left margin

Left Indent 
marker moves 
with the Hanging 
Indent marker

second line in 
paragraphs 
indented 
one-half inch

Other Ways

1. Right-click paragraph, 
click Paragraph on 
shortcut menu, click 
Indents and Spacing 
tab, click Special box 
arrow, click Hanging, 
click OK button

2. Click Paragraph Dialog 
Box Launcher, click 
Indents and Spacing 
tab, click Special box 
arrow, click Hanging, 
click OK button

3. Press CTRL+T

Q
&

A

second line in 
paragraph should 
be indented 
one-half inch
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To Modify a Source and Update the Bibliographical List

If you modify the contents of any source, the list of sources automatically updates because the list is a fi eld. 
The following steps modify the title of the magazine article.

1
• Click References on 

the Ribbon to display 
the References tab.

• Click the Manage 
Sources button on 
the References tab 
to display the Source 
Manager dialog box.

• Click the source you 
wish to edit in the 
Current List.

• Click the Edit button 
to display the Edit 
Source dialog box.

• In the Title text 
box, add the word, 
Services, to the 
end of the title 
(Figure 2–59).

OK button

word added

Edit button

source 
selected

Manage Sources 
button

Title text box

References tab
Source Manager 
dialog box

Edit Source 
dialog box

Current List 
displays sources 
in document

Master List displays 
all available 
sources — your 
list may differ

Figure 2–59

2
• Click the OK button to close the 

Edit Source dialog box.

• If a Microsoft Offi ce Word dialog 
box appears, click its Yes button 
to update all occurrences of the 
source.

• Click the Close button in the 
Source Manager dialog box and 
update the list of sources in the 
document (Figure 2–60).

What if the list of sources in 
the document does not update 
automatically? 

Click in the list of sources and 
then press the F9 key, which is the 
shortcut key to update a fi eld. 

word automatically 
added to list of 
sources 

Figure 2–60

Q
&

A

Close button
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Proofi ng and Revising the Research Paper
As discussed in Chapter 1, once you complete a document, you might fi nd it necessary to 
make changes to it. Before submitting a paper to be graded, you should proofread it. While 
proofreading, you look for grammatical errors and spelling errors. You want to be sure the 
transitions between sentences fl ow smoothly and the sentences themselves make sense. 

Proofread and revise the paper.
As you proofread the paper, look for ways to improve it. Check all grammar, spelling, and 
punctuation. Be sure the text is logical and transitions are smooth. Where necessary, add text, 
delete text, reword text, and move text to different locations. Ask yourself these questions: 

• Does the title suggest the topic? 

• Is the thesis clear? 

• Is the purpose of the paper clear? 

• Does the paper have an introduction, body, and conclusion? 

• Does each paragraph in the body relate to the thesis? 

• Is the conclusion effective? 

• Are all sources acknowledged?

Plan 
Ahead

To assist you with the proofreading effort, Word provides several tools. You can go to 
a specifi c location in a document, move text, fi nd and replace text, insert a synonym, check 
spelling and grammar, and look up information. The following pages discuss these tools. 

To Use the Select Browse Object Menu

Often, you would like to bring a certain page, footnote, or other object into view in the document window. To 
accomplish this, you could scroll through the document to fi nd a desired page, footnote, or item. Instead of scrolling 
through the document, however, you can use Word to go to a specifi c location via the Select Browse Object menu. 
The following steps display the footnote in the research paper using the Select Browse Object menu.

1
• Click the Select Browse Object 

button on the vertical scroll bar to 
display the Select Browse Object 
menu and then position the 
mouse pointer on the Browse by 
Footnote icon (Figure 2–61).

Browse by 
Footnote 
icon selected

Select 
Browse 
Object 
button

vertical 
scroll bar

Select Browse 
Object menu

when you point to an icon on the 
Select Browse Object menu, Word 
displays the associated command 
name at the top of the menu

Figure 2–61
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2
• Click the Browse by Footnote 

icon to set the browse object to 
footnotes.

• Position the mouse pointer on the 
Previous Footnote button on the 
vertical scroll bar (Figure 2–62).

Did the function of the 
button change?

Yes. By default, it is the Previous 
Page button. Depending on the 
icon you click on the Select Browse 
Object menu, the function of the 
buttons above and below the 
Select Browse Object button on 
the vertical scroll bar changes.

Previous 
Footnote 
button

Figure 2–62

3
• Click the Previous Footnote button 

to display the footnote reference 
mark in the document window 
(Figure 2–63).

footnote reference 
mark is displayed 
in document 
window

Figure 2–63

Other Ways

1. Click Page Number 
indicator on status bar, 
click desired object in 
Go to what list, type 
desired object number 
in Enter object number 
text box, click 
OK button

2. Press ALT+CTRL+HOME

Moving Text
While proofreading the research paper, you realize that text in the third paragraph 

would fl ow better if the third sentence were moved to the end of the paragraph.
To move text, such as words, characters, sentences, or paragraphs, you fi rst select 

the text to be moved and then use drag-and-drop editing or the cut-and-paste technique 
to move the selected text. With drag-and-drop editing, you drag the selected item to 
the new location and then insert, or drop, it there. Cutting involves removing the selected 
item from the document and then placing it on the Clipboard. The Clipboard is a tempo-
rary Windows storage area. Pasting is the process of copying an item from the Clipboard 
into the document at the location of the insertion point. 

When moving text a long distance or between application programs, use the 
Clipboard task pane to cut and paste. When moving text a short distance, the drag-and-
drop technique is more effi cient. Thus, the steps on the following pages demonstrate 
drag-and-drop editing.

Q
&

A
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To Select a Sentence

To drag-and-drop a sentence in the research paper, you fi rst must select the sentence. The following step 
selects a sentence.

1
• Position the mouse pointer in the 

sentence to be moved (shown in 
Figure 2–64).

• Press and hold down the CTRL key. 
While holding down the CTRL key, 
click the sentence to select the 
entire sentence.

• Release the CTRL key.

sentence 
selected

dimmed Mini toolbar 
automatically appears 
when you select text

space following 
period automatically 
included in selection

Other Ways

1. Drag through the 
sentence

2. With insertion point at 
beginning of sentence, 
press CTRL+SHIFT+RIGHT 
ARROW until sentence is 
selected

Figure 2–64

Selecting Text
In the previous steps and throughout Chapters 1 and 2, you have selected text. 

Table 2–3 summarizes the techniques used to select various items with the mouse.

Table 2–3 Techniques for Selecting Items with the Mouse

Item To Select Mouse Action

Block of text Click at beginning of selection, scroll to end of selection, position mouse pointer at end of 
selection, hold down SHIFT key and then click; or drag through the text

Character(s) Drag through character(s)

Document Move mouse to left of text until mouse pointer changes to a right-pointing block arrow and 
then triple-click

Graphic Click the graphic

Line Move mouse to left of line until mouse pointer changes to a right-pointing block arrow and 
then click

Lines Move mouse to left of fi rst line until mouse pointer changes to a right-pointing block arrow 
and then drag up or down

Paragraph Triple-click paragraph; or move mouse to left of paragraph until mouse pointer changes to 
a right-pointing block arrow and then double-click

Paragraphs Move mouse to left of paragraph until mouse pointer changes to a right-pointing block 
arrow, double-click, and then drag up or down

Sentence Press and hold down CTRL key and then click sentence

Word Double-click the word

Words Drag through words

Selecting Nonadjacent 
Items
In Word, you can select 
nonadjacent items, 
that is, items not next 
to each other. This is 
helpful when you are 
formatting multiple 
items the same way. To 
select nonadjacent items 
(text or graphics), do the 
following: select the fi rst 
item, such as a word or 
paragraph, as usual. Press 
and hold down the CTRL 
key. While holding down 
the CTRL key, select any 
additional items.

B
T
W
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3
• Release the mouse button to 

move the selected text to the 
location of the mouse pointer.

• Click outside the selected text to 
remove the selection (Figure 2–67). 

What if I accidentally drag text to 
the wrong location? 

Click the Undo button on the 
Quick Access Toolbar and 
try again.

Can I use drag-and-drop editing 
to move any selected item? 

Yes, you can select words, 
sentences, phrases, and graphics 
and then use drag-and-drop 
editing to move them. 

To Move Selected Text

With the sentence to be moved selected, you can use drag-and-drop editing to move it. You should be sure 
that drag-and-drop editing is enabled by clicking the Word Options button on the Offi ce Button menu, clicking 
Advanced in the left pane of the Word Options dialog box, verifying the 'Allow text to be dragged and dropped' 
check box is selected, and then clicking the OK button.

The following steps move the selected sentence so that it becomes the last sentence in the paragraph.

1
• With the mouse pointer in the 

selected text, press and hold down 
the mouse button (Figure 2–65).

mouse pointer has a small 
box below it when you 
begin to drag selected text

sentence to be 
moved is selected

Figure 2–65

2
• Drag the mouse pointer to the 

location where the selected text 
is to be moved, as shown in 
Figure 2–66.

selected sentence 
to be dropped at 
location of mouse 
pointer

sentence 
remains 
selected

Figure 2–66

sentence 
moved

Paste 
Options 
button

Figure 2–67

Q
&

A
Q

&
A

1. Click Cut button on Home 
tab, click where text is to be 
pasted, click Paste button on 
Home tab

2. Right-click selected text, 
click Cut on shortcut menu, 
right-click where text is to 
be pasted, click Paste on 
shortcut menu

3. Press CTRL+X, position 
insertion point where text is 
to be pasted, press CTRL+V

Other Ways
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To Display the Paste Options Menu

When you drag-and-drop text, Word automatically displays a Paste Options button near the location of the 
drag-and-dropped text (Figure 2–67 on the previous page). If you click the Paste Options button, a menu appears 
that allows you to change the format of the item that was moved. The following steps display the Paste Options menu.

1
• Click the Paste Options button to 

display the Paste Options menu 
(Figure 2–68).

What is the purpose of the 
commands on the Paste 
Options menu?

In general, the fi rst command 
indicates the pasted text should 
look the same as it did in its 
original location. The second com-
mand formats the pasted text to 
match the rest of the text where 
it was pasted. The third command 
removes all formatting from the 
pasted text. The last command 
displays the Word Options 
dialog box.

2
• Press the ESCAPE key to remove 

the Paste Options menu from the 
window. Paste Options 

button

Paste Options 
menu

Figure 2–68

Q
&

A

Dragging-and-
Dropping
If you hold down the 
CTRL key while dragging 
a selected item, Word 
copies the item instead 
of moving it.

B
T
W
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To Find and Replace Text

While proofreading the paper, you notice that you typed 3-G in the third paragraph (Figure 2–69). You prefer 
to use 3G, instead. Therefore, you need to change all occurrences of 3-G to 3G. To do this, you can use Word’s fi nd 
and replace feature, which automatically locates each occurrence of a word or phrase and then replaces it with 
specifi ed text. The following steps use Find and Replace to replace all occurrences of 3-G with 3G.

1
• Click Home on the 

Ribbon to display 
the Home tab. Click 
the Replace button 
on the Home tab to 
display the Find and 
Replace dialog box.

• Type 3-G in the Find 
what text box. 

• Press the TAB key. 
Type 3G in the 
Replace with text 
box (Figure 2–69).

Figure 2–69

text to be replaced

Replace tab

Replace 
button

new text to replace 
current text

Find and Replace 
dialog box

2
• Click the Replace All button in the 

Find and Replace dialog box to 
instruct Word to replace all occur-
rences of the fi nd what text with 
the replace with text (Figure 2–70).

3
• Click the OK button in the 

Microsoft Offi ce Word dialog box. 

• Click the Close button in the Find 
and Replace dialog box.

Figure 2–70

dialog box 
indicates 2 
replacements 
were made

Replace All 
button

Find Next 
button

OK button
Other Ways

1. Click Select Browse 
Object button on 
vertical scroll bar, 
click Find icon, click 
Replace tab

2. Click Page Number 
indicator on status bar, 
click Replace tab in 
dialog box

3. Press CTRL+H

two occurrences 
of 3-G

3-G changed 
to 3G

Microsoft Offi ce 
Word dialog box
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Find and Replace Dialog Box
The Replace All button in the Find and Replace dialog box replaces all occurrences 

of the Find what text with the Replace with text. In some cases, you may want to replace 
only certain occurrences of a word or phrase, not all of them. To instruct Word to confi rm 
each change, click the Find Next button in the Find and Replace dialog box (Figure 2–70 on 
the previous page), instead of the Replace All button. When Word locates an occurrence of 
the text, it pauses and waits for you to click either the Replace button or the Find Next button. 
Clicking the Replace button changes the text; clicking the Find Next button instructs Word 
to disregard the replacement and look for the next occurrence of the Find what text.

If you accidentally replace the wrong text, you can undo a replacement by clicking the 
Undo button on the Standard toolbar. If you used the Replace All button, Word undoes 
all replacements. If you used the Replace button, Word undoes only the most recent 
replacement.

TO FIND TEXT

Sometimes, you may want only to fi nd text, instead of fi nding and replacing text. To 
search for just a single occurrence of text, you would follow these steps.
1. Click the Find button on the Home tab; or click the Select Browse Object button on 

the vertical scroll bar and then click the Find icon on the Select Browse Object menu; or 
click the page indicator on the status bar and then click the Find tab; or press CTRL+F.

2. Type the text to locate in the Find what text box and then click the Find Next button. 
To edit the text, click the Cancel button in the Find and Replace dialog box; to fi nd the 
next occurrence of the text, click the Find Next button.

To Find and Insert a Synonym

When writing, you may discover that you used the same word in multiple locations or that a word you used 
was not quite appropriate. In these instances, you will want to look up a synonym, or a word similar in meaning, to 
the duplicate or inappropriate word. A thesaurus is a book of synonyms. Word provides synonyms and a thesaurus 
for your convenience.

In this project, you would like a synonym for the word, proper, in the fi rst paragraph of the research paper. 
The following steps show how to fi nd a suitable synonym.

1
• Right-click the word 

for which you want 
to fi nd a synonym 
(in this case, proper) 
to display a shortcut 
menu related to 
the word you 
right-clicked.

• Point to Synonyms 
on the shortcut 
menu to display a list 
of synonyms for 
the word you right-
clicked (Figure 2–71).

Figure 2–71

Synonyms 
command

synonym to 
be selected

shortcut 
menu

clicking Thesaurus 
command displays 
Research task pane

Mini toolbar 
automatically 
appears

insertion 
point in 
word to be 
looked up

list of 
synonyms

Finding Formatting
To search for formatting 
or a special character, 
click the More button 
in the Find dialog box. 
To fi nd formatting, use 
the Format button in the 
Find dialog box. To fi nd a 
special character, use the 
Special button.

B
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• Click the synonym you want 

(appropriate) on the Synonyms 
submenu to replace the word, 
proper, in the document with the 
word, appropriate (Figure 2–72).

What if the synonyms list on the 
shortcut menu does not display a 
suitable word? 

You can display the thesaurus in 
the Research task pane by click-
ing Thesaurus on the Synonyms 
submenu. The Research task pane 
displays a complete thesaurus, in 
which you can look up synonyms for 
various meanings of a word. You also can look up an antonym, or word with an opposite meaning. The Research task 
pane is discussed later in this chapter. 

Figure 2–72

word, proper, 
changed to 
appropriate

To Check Spelling and Grammar at Once

As discussed in Chapter 1, Word checks spelling and grammar as you type and places a wavy underline below 
possible spelling or grammar errors. Chapter 1 illustrated how to check these fl agged words immediately. As an 
alternative, you can wait and check the entire document for spelling and grammar errors at once.

In the following example the word, world, has been misspelled intentionally as wrld to illustrate the use of 
Word’s check spelling and grammar at once feature. If you are completing this project on a personal computer, your 
research paper may contain different misspelled words, depending on the accuracy of your typing.

1
• Press CTRL+HOME 

because you want 
the spelling and 
grammar check to 
begin from the top 
of the document.

• Click Review on the 
Ribbon to display the 
Review tab.

• Click the Spelling & 
Grammar button on 
the Review tab to 
begin the spelling 
and grammar check 
at the location of 
the insertion point, 
which in this case, 
is at the beginning 
of the document 
(Figure 2–73). 

1. Click Thesaurus on 
Review tab

2. Press SHIFT+F7

Other Ways

Figure 2–73

Review tab

Change 
button

Spelling & 
Grammar button

world 
selected

misspelled 
word

the word, wrld, 
not found in 
dictionary

Spelling and Grammar 
dialog box appears when 
spelling or grammar 
error is detected

Q
&

A

list of suggestions 
for fl agged word
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2
• With the word, world, selected 

in the Suggestions list, click the 
Change button in the Spelling 
and Grammar dialog box to 
change the fl agged word, wrld, 
to the selected suggestion, world, 
and then continue the spelling 
and grammar check until the next 
error is identifi ed or the end 
of the document is reached 
(Figure 2–74).

3
• Click the Ignore All button in the 

Spelling and Grammar dialog box 
to ignore this and future occur-
rences of the fl agged proper 
noun and then continue the spell-
ing and grammar check until the 
next error is identifi ed or the end 
of the document is reached.

4
• When Word fl ags the proper 

noun, Podpora, click the Ignore 
All button. 

• When the spelling and grammar 
check is fi nished and Word displays 
a dialog box, click its OK button.

Can I check spelling of just a 
section of a document?

Yes, select the text before starting 
the spelling and grammar check. 

Ignore All 
button

Add to 
Dictionary 
button

fl agged word is 
a proper noun

proper noun, 
Cashman, 
not found in 
dictionary

Figure 2–74

Other Ways

1. Click Spelling and 
Grammar Check icon on 
status bar, click Spelling 
on shortcut menu

2. Right-click fl agged 
word, click Spelling on 
shortcut menu

3. Press F7

Q
&

A
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The Main and Custom Dictionaries
As shown in the previous steps, Word may fl ag a proper noun as an error because 

the proper noun is not in its main dictionary. To prevent Word from fl agging proper 
nouns as errors, you can add the proper nouns to the custom dictionary. To add a correctly 
spelled word to the custom dictionary, click the Add to Dictionary button in the Spelling 
and Grammar dialog box (Figure 2–74) or right-click the fl agged word and then click Add 
to Dictionary on the shortcut menu. Once you have added a word to the custom dictionary, 
Word no longer will fl ag it as an error. 

TO VIEW OR MODIFY ENTRIES IN A CUSTOM DICTIONARY

To view or modify the list of words in a custom dictionary, you would follow 
these steps.
1. Click the Offi ce Button and then click the Word Options button.
2. Click Proofi ng in the left pane of the Word Options dialog box.
3. Click the Custom Dictionaries button.
4. When Word displays the Custom Dictionaries dialog box, place a check mark next to 

the dictionary name to view or modify. Click the Edit Word List button. (In this dialog 
box, you can add or delete entries to and from the selected custom dictionary.)

5. When fi nished viewing and/or modifying the list, click the OK button in the dialog box.
6. Click the OK button in the Custom Dictionaries dialog box. 
7. If the ‘Suggest from main dictionary only’ check box is selected in the Word Options 

dialog box, remove the check mark. Click the OK button in the Word Options 
dialog box.

TO SET THE DEFAULT CUSTOM DICTIONARY

If you have multiple custom dictionaries, you can specify which one Word should use 
when checking spelling. To set the default custom dictionary, you would follow these steps.
1. Click the Offi ce Button and then click the Word Options button.
2. Click Proofi ng in the left pane of the Word Options dialog box.
3. Click the Custom Dictionaries button.
4. When the Custom Dictionaries dialog box is displayed, place a check mark next to the 

desired dictionary name. Click the Change Default button.
5. Click the OK button in the Custom Dictionaries dialog box.
6. If the ‘Suggest from main dictionary only’ check box is selected in the Word Options 

dialog box, remove the check mark. Click the OK button in the Word Options 
dialog box.
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To Use the Research Task Pane to Look Up Information

From within Word, you can search through various forms of reference information. Earlier, this chapter 
discussed the Research task pane with respect to looking up a synonym in a thesaurus. Other services available in the 
Research task pane include a dictionary and if you are connected to the Web, an encyclopedia, a search engine, and 
other Web sites that provide information such as stock quotes, news articles, and company profi les.

Assume want to know more about the acronym, PDA. The following steps use the Research task pane to look 
up information about a word.

1
• While holding down the ALT 

key, click the word you want to 
look up (in this case, PDAs) to 
open the Research task pane and 
display a dictionary entry for the 
ALT+CLICKED word. Release the 
ALT key (Figure 2–75).

• If the Research task pane does 
not display a dictionary entry for 
the ALT+CLICKED word, click the 
Search for box arrow and then 
click All Reference Books.

insertion point in word 
you ALT+CLICKED

red X changed to blue 
check mark because 
document contains no 
spelling or grammar errors

Search 
for box 
arrow

Research 
task pane

ALT+CLICKED word 
is displayed in 
Search for text box

All Reference Books 
searches through 
dictionaries and 
thesauruses

defi nition of ALT+CLICKED 
word — your entry may 
differ depending on 
research options settings

Figure 2–75

C6158_WRD_02.4c.indd   128C6158_WRD_02.4c.indd   128 3/6/07   3:10:27 PM3/6/07   3:10:27 PM



W
o

rd
 C

h
ap

te
r 

2Proofi ng and Revising the Research Paper   WD 129

2
• Click the Search for box arrow and 

then click All Research Sites in the 
list to display Web sites with 
information about the ALT+CLICKED 
word (Figure 2–76).

Can I copy information from the 
Research task pane into my 
document? 

Yes, you can use the Copy and 
Paste commands. When using 
Word to insert material from the 
Research task pane or any other 
online reference, however, be very 
careful not to plagiarize. 

3
• Click the Close button in the 

Research task pane.

Figure 2–76

Research task 
pane Close 
button

Search 
for box 
arrow

All Research Sites 
searches through 
selected Web sites

encyclopedia entry for 
ALT+CLICKED word 
— your entry may differ 
depending on research 

Research options link allows you to 
specify the research services (books 
and Web sites) Word will use when 
searching via the Research task pane

Research Task Pane Options
When you install Word, it selects a series of services (reference books and Web 

sites) through which it searches when you use the Research task pane. You can view, 
modify, and update the list of services at any time. 

Clicking the Research options link at the bottom of the Research task pane dis-
plays the Research Options dialog box, where you can view or modify the list of installed 
services. You can view information about any installed service by clicking the service in 
the list and then clicking the Properties button. To activate an installed service, click the 
check box to its left; likewise, to deactivate a service, remove the check mark. To add a 
particular Web site to the list, click the Add Services button, enter the Web address in the 
Address text box, and then click the Add button in the Add Services dialog box. To update 
or remove services, click the Update/Remove button, select the service in the list, click 
the Update (or Remove) button in the Update or Remove Services dialog box, and then 
click the Close button. You also can install parental controls, if minor children use Word, 
through the Parental Control button in the Research Options dialog box.

Q
&

A

clicking plus sign to left of entries 
will display more Web sites related to 
ALT+CLICKED word — your entry may differ 
depending on research options settings

Other Ways

1. Click Insert Citation 
button on References 
tab, click Search 
Libraries
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To Change Document Properties

Before saving the research paper again, you want to add your name, course information, 
and some keywords as document properties. The following steps use the Document 
Information Panel to change document properties.

1  Click the Offi ce Button to display the Offi ce Button menu, point to Prepare on the Offi ce 
Button menu, and then click Properties on the Prepare submenu to display the Document 
Information Panel.

2  Click the Author text box, if necessary, and then type your name as the Author property. If 
a name already is displayed in the Author text box, delete it before typing your name.

3  Click the Subject text box, if necessary delete any existing text, and then type your course 
and section as the Subject property.

4  Click the Keywords text box, if necessary delete any existing text, and then type instant 
messaging, Internet access points, global positioning systems as the 
Keywords property.

5  Click the Close the Document Information Panel button so that the Document Information 
Panel no longer is displayed.

To Save an Existing Document with the Same File Name

The document now is complete. You should save the research paper again. The 
following step saves the document again.

1  Click the Save button on the Quick Access Toolbar to overwrite the previous Wireless 
Communications Paper fi le on the USB fl ash drive.

To Print Document Properties and then the Document

With the document properties entered and the completed document saved, you may want to print the document 
properties along with the document. The following steps print the document properties, followed by the contents of 
the saved Wireless Communications Paper project.

1
• Click the Offi ce Button to display 

the Offi ce Button menu and then 
point to Print on the Offi ce Button 
menu to display the Print submenu 
(Figure 2–77).

Offi ce Button

Print 
command

Print command on 
Print submenu

Print Preview 
command allows you 
to see a document 
before printing it

Figure 2–77

Conserving Ink and 
Toner
You can instruct 
Word to print draft 
quality documents to 
conserve ink or toner 
by clicking the Offi ce 
Button, clicking the 
Word Options button, 
clicking Advanced in the 
left pane of the Word 
Options dialog box, 
scrolling to the Print 
area, placing a check 
mark in the ‘Use draft 
quality’ check box, and 
then clicking the 
OK button. Click the 
Offi ce Button, point 
to Print, and then click 
Quick Print.

B
T
W
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2
• Click Print on the Print submenu to 

display the Print dialog box.

• Click the Print what box arrow and 
then click Document properties to 
instruct Word to print the docu-
ment properties instead of the 
document (Figure 2–78).

OK button

Print what 
box arrow

Print 
dialog box

indicates number 
of copies that will 
be printed

clicking Options 
button displays 
Word Option 
dialog box

Figure 2–78

3
• Click the OK button to print the 

document properties (Figure 2–79).

4
• Click the Offi ce Button again to 

display the Offi ce Button menu, 
point to Print on the Offi ce Button 
menu, and then click Quick Print 
on the Print submenu to print the 
research paper (shown in 
Figure 2–1 on page WD 75).

printed document 
properties — your 
properties may differ, 
depending on settings

Figure 2–79

C6158_WRD_02.4c.indd   131C6158_WRD_02.4c.indd   131 3/6/07   3:10:32 PM3/6/07   3:10:32 PM



WD 132   Word Chapter 2   Creating a Research Paper

To Quit Word

This project is complete. The following steps quit Word.

1  Click the Close button on the right side of the title bar to quit Word. 

2  If necessary, click the Yes button in the Microsoft Offi ce Word dialog box so that any 
changes you have made are saved.

Chapter Summary
In this chapter you have learned how to change document settings, use headers to number pages, create and modify 
styles, insert and edit citations and their sources, add footnotes, create a bibliographical list of sources, and use the 
Research task pane. The items listed below include all the new Word skills you have learned in this chapter.
 1. Double-Space Text (WD 78)
 2. Remove Space after a Paragraph (WD 79)
 3. Switch to the Header (WD 80)
 4. Right-Align a Paragraph (WD 81)
 5. Insert a Page Number (WD 82)
 6. Close the Header (WD 83)
 7. Click and Type (WD 85)
 8. Display the Rulers (WD 87)
 9. First-Line Indent Paragraphs (WD 88)
 10. Create a Quick Style (WD 90)
 11. AutoCorrect as You Type (WD 91)
 12. Use the AutoCorrect Options Button (WD 92)
 13. Create an AutoCorrect Entry (WD 93)
 14. Change the Bibliography Style (WD 95)
 15. Insert a Citation and Create Its Source (WD 96)
 16. Edit a Citation (WD 98)
 17. Insert a Footnote Reference Mark (WD 100)
 18. Insert a Citation Placeholder (WD 101)
 19. Modify a Style Using a Shortcut Menu (WD 102)
 20. Edit a Source (WD 104)
 21. Count Words (WD 107)

 22. Page Break Manually (WD 112)
 23. Create the Bibliographical List (WD 113)
 24. Modify a Style Using the Styles Task Pane (WD 114)
 25. Create a Hanging Indent (WD 116)
 26. Modify a Source and Update the Bibliographical 

List (WD 117)
 27. Use the Select Browse Object Menu (WD 118)
 28. Select a Sentence (WD 120)
 29. Move Selected Text (WD 121)
 30. Display the Paste Options Menu (WD 122)
 31. Find and Replace Text (WD 123)
 32. Find Text (WD 124)
 33. Find and Insert a Synonym (WD 124)
 34. Check Spelling and Grammar at Once (WD 125)
 35. View or Modify Entries in a Custom Dictionary 

(WD 127)
 36. Set the Default Custom Dictionary (WD 127)
 37. Use the Research Task Pane to Look Up 

Information (WD 128)
 38. Print Document Properties and then the 

Document (WD 130)

If you have a SAM user profi le, you may have access to hands-on instruction, practice, and 
assessment. Log in to your SAM account (http://sam2007.course.com) to launch any assigned 
training activities or exams that relate to the skills covered in this chapter.

Certifi cation
The Microsoft Certifi ed 
Application Specialist 
(MCAS) program provides 
an opportunity for you to 
obtain a valuable industry 
credential – proof that you 
have the Word 2007 skills 
required by employers. 
For more information, see 
Appendix F or visit the 
Word 2007 Certifi cation 
Web page (scsite.com/
wd2007/cert).

B
T
W

Quick Reference
For a table that lists how to complete the tasks 
covered in this book using the mouse, Ribbon, 
shortcut menu, and keyboard, see the Quick 
Reference Summary at the back of this book, or 
visit the Word 2007 Quick Reference Web page 
(scsite.com/wd2007/qr).

B
T
W
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Learn It Online

Test your knowledge of chapter content and key terms.

Instructions: To complete the Learn It Online exercises, start your browser, click the Address bar, and 
then enter the Web address scsite.com/wd2007/learn. When the Word 2007 Learn It Online 
page is displayed, click the link for the exercise you want to complete and then read the instructions.

Chapter Reinforcement TF, MC, and SA
A series of true/false, multiple choice, and short 
answer questions that test your knowledge of the 
chapter content. 

Flash Cards
An interactive learning environment where 
you identify chapter key terms associated with 
displayed defi nitions. 

Practice Test
A series of multiple choice questions that test 
your knowledge of chapter content and key terms. 

Who Wants To Be a Computer Genius?
An interactive game that challenges your 
knowledge of chapter content in the style of a 
television quiz show.

Wheel of Terms
An interactive game that challenges your 
knowledge of chapter key terms in the style of the 
television show Wheel of Fortune.

Crossword Puzzle Challenge
A crossword puzzle that challenges your 
knowledge of key terms presented in the chapter. 

Apply Your Knowledge 

Reinforce the skills and apply the concepts you learned in this chapter.

Revising Text and Paragraphs in a Document
Instructions: Start Word. Open the document, Apply 2-1 Software Paragraphs Draft, from the Data 
Files for Students. See the inside back cover of this book for instructions on downloading the Data 
Files for Students, or contact your instructor for information about accessing the required fi les.

The document you open has a header and three paragraphs of text. You are to revise the document 
as follows: move a paragraph, move a word and change the format of the moved word, change paragraph 
indentation, change line spacing and paragraph spacing, replace all occurrences of a word with another 
word, and edit the header. 

Continued >

Perform the following tasks:
 1. Select the last (third) paragraph. Use drag-and-drop editing to move this paragraph, so that it is 

the second paragraph in the document.

 2. Select the underlined word, effectively, in the second sentence of the fi rst paragraph. Use drag-
and-drop editing to move the selected word, effectively, so it follows the word, software, in the 
same sentence. Click the Paste Options button that displays to the right of the moved word, 
effectively. Remove the underline format from the moved sentence by clicking Keep Text Only on 
the shortcut menu.

 3. Select the three paragraphs of text in the document.

 4. Display the ruler, if necessary. With the paragraphs selected, use the ruler to indent the fi rst line of 
the selected paragraphs one-half inch.

 5. With the paragraphs still selected, change the line spacing of the selected paragraphs from single 
to double.
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Figure 2–80

word 
moved

page number 
inserted

paragraph 
moved

paragraphs 
double-spaced; space 
after paragraphs 
removed

No Spacing style applied to 
fi rst paragraph in header

fi rst line of each paragraph 
indented one-half inch

header paragraphs 
right-aligned

Apply Your Knowledge continued

 6. With the paragraphs still selected, use Line spacing box arrow to remove extra space below (after) 
the paragraphs. Click anywhere to remove the selection.

 7. Use the Find and Replace dialog box to replace all occurrences of the word, Internet, with the 
word, Web. How many replacements were made?

 8. Use Word’s thesaurus to change the word, incorporated, to the word, integrated, in the fi rst 
sentence of the second paragraph.

 9. Switch to the header so you can edit it. In the fi rst line of the header, change the word, Draft, to 
the word, Modifi ed, so it reads: Software Paragraphs Modifi ed. Change the fi rst line of the header 
from the Normal style to the No Spacing style.

 10. In the second line of the header, insert and center the page number (with no formatting) one space 
after the word, Page. 

 11. Change the alignment of both lines of text in the header from left-aligned to right-aligned. Switch 
back to the document text.

 12. Change the document properties, as specifi ed by your instructor. 
 13. Click the Offi ce Button and then click Save As. Save the document using the fi le name, Apply 2-1 

Software Paragraphs Modifi ed.
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 14. Print the document properties and then print the revised document, shown in Figure 2–80.

 15. Use the Research task pane to look up the defi nition of the word, online, in the fi rst sentence of 
the second paragraph. Handwrite the COMPUTING defi nition of the word, online, on your 
printout.

 16. Display the Research Options dialog box and on your printout, handwrite the currently active 
Reference Books, Research Sites, and Business and Financial Sites. If your instructor approves, 
activate one of the services.

Extend Your Knowledge

Extend the skills you learned in this chapter and experiment with new skills. You may need to 
use Help to complete the assignment.

Working with References and Proofi ng Tools
Instructions: Start Word. Open the document, Extend 2-1 Computing Options Paper Draft, from the 
Data Files for Students. See the inside back cover of this book for instructions on downloading the Data 
Files for Students, or contact your instructor for information on accessing the required fi les.

You will add another footnote to the paper, use the thesaurus, convert the document from MLA 
to APA style, convert the footnotes to endnotes, modify the Endnote Text style, change the format of 
the note reference marks, and translate the document to another language.

Perform the following tasks:
 1. Insert a second footnote at an appropriate place in the research paper. Use the following footnote 

text: The Americans with Disabilities Act (ADA) requires any company with 15 or more employees 
to make reasonable attempts to accommodate the needs of physically challenged workers.

 2. Use the Find dialog box to fi nd the word, imagine, in the document and use Word to help you 
determine an appropriate synonym.

 3. Save the document with a new fi le name and then print it. Select the entire document and then 
change the style of the citations and bibliography from MLA to APA. Save the APA version of the 
document with a new fi le name and then print it. Compare the two versions. Circle the differences 
between the two documents.

 4. Convert the footnotes to endnotes.

 5. Modify the Endnote Text style to 11-point Calibri font, double-spaced text with a fi rst-line indent.

 6. Change the format of the note reference marks to capital letters (A, B, etc.).

 7. Save the revised document with endnotes with a new fi le name and then print it. On the printout 
with the endnotes, write the number of words, characters without spaces, characters with spaces, 
paragraphs, and lines in the document. Be sure to include endnote text in the statistics.

 8. Translate the research paper into a language of your choice (Figure 2–81 on the next page) using 
the Translate button on the Review tab. Print the translated document.

Extend Your Knowledge   WD 135

Continued >
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research paper 
translated from 
English to Dutch 

Figure 2–81

Make It Right

Analyze a document and correct all errors and/or improve the design.

Inserting Missing Elements in an MLA Style Research Paper
Instructions: Start Word. Open the document, Make It Right 2-1 Certifi cation Paper Draft, from 
the Data Files for Students. See the inside back cover of this book for instructions on downloading 
the Data Files for Students, or contact your instructor for information on accessing the required fi les.

The document is a research paper that is missing several elements. You are to insert these miss-
ing elements, all formatted according to the MLA documentation style: header with a page number, 
heading (name, course, and date information), paper title, footnote, and source information for the 
fi rst citation and the citation in the footnote.

Perform the following tasks:
 1. Insert a header with a page number, heading (use your own information: name, course 

information, and date), and an appropriate paper title, all formatted according to the MLA style. 
 2. Use the Select Browse Object button to go to page 2. How many bibliographical entries currently 

are on the Works Cited page? You will create additional source entries in Steps 3 and 4.
 3. The Otoole placeholder (tag name) is missing its source information (Figure 2–82). Use the 

following source information to edit the source: magazine article titled “Career Builders and 
Boosts,” written by Sarah W. O’Toole, magazine name is IT World and Certifi cations, publication 
date is March 2008, article is on pages 88-93. Edit the citation so it displays the author name and 
the page numbers.

Extend Your Knowledge continued
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Figure 2–82

citation 
placeholder

 4. Insert the following footnote with the note reference at an appropriate place in the paper, 
formatted according to the MLA style: Debbins points out that, as an additional bonus, some 
certifi cation training can be used for college credit. The citation for this footnote should be at the 
end of the footnote. The source information is as follows: book named Preparing for the Future: 
IT Strategies, authored by Floyd I. Debbins, published in 2008 at IT World Press in Boston, 
pages 99-104. Edit the citation so it only displays page numbers.

 5. Use the Select Browse Object button to go to page 3. Be sure the bibliographical list on the Works 
Cited page contains all three entries. If necessary, use the F9 key to update the bibliographical list. 
Format the bibliographical paragraphs with a one-half inch hanging indent.

 6. Use the Select Browse Object button to go to the footnote. Be sure the footnote is formatted 
properly.

 7. Change the document properties, as specifi ed by your instructor. Save the revised document with a 
new fi le name and then submit it in the format specifi ed by your instructor.

Make It Right   WD 137
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Figure 2–83

In the Lab

Design and/or create a document using the guidelines, concepts, and skills presented in this 
chapter. Labs are listed in order of increasing diffi culty.

Lab 1: Preparing a Short Research Paper
Problem: You are a college student currently enrolled in an introductory business class. Your assignment 
is to prepare a short research paper (300-350 words) about a computer-related job. The requirements 
are that the paper be presented according to the MLA documentation style and have three references. 
One of the three references must be from the Web. You prepare the paper shown in Figure 2–83, 
which discusses the computer forensics specialist.

(a)
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Instructions: Perform the following tasks:
 1. If necessary, display formatting marks on the screen.

 2. Adjust line spacing to double.

 3. Remove space below (after) paragraphs.

 4. Create a header to number pages.

 5. Type the name and course information at the left margin. Center and type the title.

 6. Set fi rst-line indent for paragraphs in the body of the research paper.

 7. Create a Quick Style for the research paper paragraphs.

 8. Type the research paper as shown in Figures 2–83a and 2–83b. Change the bibliography style to 
MLA. As you insert citations, enter their source information (shown in Figure 2–83c). Edit the 
citations so they display according to Figures 2–83a and 2–83b.

 9. At the end of the research paper text, press the ENTER key and then insert a manual page break so the 
Works Cited page begins on a new page. Enter and format the works cited title (Figure 2–83c). Use 
Word to insert the bibliographical list. Format the paragraphs in the list with a hanging indent.

 10. Check the spelling and grammar of the paper at once.

 11. Save the document on a USB fl ash drive using Lab 2-1 Computer Forensics Paper as the fi le name.

 12. Print the research paper. Handwrite the number of words, paragraphs, and characters in the 
research paper above the title of your printed research paper.

Figure 2–83 (continued)

(b)

(c)

In the Lab   WD 139
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In the Lab

Lab 2: Preparing a Research Report with a Footnote
Problem: You are a college student enrolled in an introductory English class. Your assignment is to 
prepare a short research paper in any area of interest to you. The requirements are that the paper be 
presented according to the MLA documentation style, contain at least one explanatory note positioned 
as a footnote, and have three references. One of the three references must be from the Internet. You 
prepare a paper about antivirus programs (Figure 2–84).

(a)

Figure 2–84
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Figure 2–84 (continued)

(b)

Instructions: Perform the following tasks:
 1. Adjust line spacing to double and remove space below (after) paragraphs. Create a header to 

number pages. Type the name and course information at the left margin. Center and type the title. 
Set fi rst-line indent for paragraphs in the body of the research paper. Create a Quick Style for the 
research paper paragraphs.

 2. Type the research paper as shown in Figures 2–84a and 2–84b. Add the footnote as shown in 
Figure 2–84a. Change the Footnote Text style to the format specifi ed in the MLA style. As you 
insert citations, use the following source information: 

a. Type of Source: Periodical
 Author: Bulowski, Dana
 Title: Protection and Precaution: Keeping Your Computer Healthy
 Periodical Title: Computing Today
 Year: 2008
 Month: February
 Pages 55-61
b. Type of Source: Book
 Author: Karanos, Hector
 Title: Internet Security
 Year: 2008
 City: Indianapolis
 Publisher: Citywide Cyber Press
c. Type of Source: Document From Web site
 Author: Shelly, Gary B., and Thomas J. Cashman
 Name of Web page: Antivirus Programs
 Production Company: Course Technology
 Year Accessed: 2008
 Month Accessed: February
 Day Accessed: 7
 URL: www.scsite.com/wd2007/pr2/wc.htm

 3. At the end of the research paper text, press the ENTER key once and insert a manual page break so 
the Works Cited page begins on a new page. Enter and format the works cited title. Use Word to 
insert the bibliographical list. Format the paragraphs in the list with a hanging indent.

 4. Check the spelling and grammar of the paper.

 5. Save the document on a USB fl ash drive using Lab 2-2 Antivirus Programs Paper as the fi le name.
 6. Print the research paper. Handwrite the number of words, including the footnotes, in the research 

paper above the title of your printed research paper.

In the Lab   WD 141
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In the Lab

Lab 3: Composing a Research Paper from Notes
Problem: You have drafted the notes shown in Figure 2–85. Your assignment is to prepare a short 
research paper from these notes.

Figure 2–85

Instructions: Perform the following tasks:
 1. Review the notes in Figure 2–85 and then rearrange and reword them. Embellish the paper as 

you deem necessary. Present the paper according to the MLA documentation style. Create an 
AutoCorrect entry that automatically corrects the spelling of the misspelled word, wird, to the 
correct spelling, wired. Add a footnote that refers the reader to the Web for more information. 
Enter citations and their sources as shown. Create the works cited page from the listed sources. 

 2. Check the spelling and grammar of the paper. Save the document on a USB fl ash drive using 
Lab 2-3 Home Networks Paper as the fi le name. 

 3. Use the Research task pane to look up a defi nition of a word in the paper. Copy and insert the 
defi nition into the document as a footnote. Be sure to quote the defi nition and cite the source.

 4. Print the research paper. Handwrite the number of words, including the footnotes, in the research 
paper above the title of the printed research paper. 
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Cases and Places

Apply your creative thinking and problem solving skills to design and implement a solution. 

• EASIER    •• MORE DIFFICULT

• 1: Create a Research Paper about Word Using the MLA Documentation Style
Chapter 1 of this book discussed the components of the Word window (pages WD 6 through 11). 
Using the material presented on those pages, write a short research paper (350–400 words) that 
describes the purpose and functionality of one or more of these components: document window, 
Ribbon, Mini toolbar and shortcut menus, Quick Access Toolbar, and Offi ce Button. Use your 
textbook and Word Help as sources. Include at least two citations and one explanatory note positioned 
as a footnote. Add an AutoCorrect entry to correct a word you commonly mistype. Use the concepts 
and techniques presented in this chapter to format the paper according to the MLA documentation 
style. Check spelling and grammar of the fi nished paper.

•• 2: Create the Research Paper Presented in this Chapter Using the APA 
Documentation Style
As discussed in this chapter, two popular documentation styles for research papers are the Modern 
Language Association of America (MLA) and American Psychological Association (APA) styles. In this 
chapter, you created a research paper that followed guidelines of the MLA documentation style. Using 
the school library, this textbook, other textbooks, the Internet, magazines, or other sources, research the 
guidelines of the APA documentation style. Then, prepare the Wireless Communications Paper from this 
chapter following the guidelines of the APA documentation style. Use Figure 2–1 on page WD 75 as a 
starting point for the text and source information. Check spelling and grammar of the fi nished paper.

•• 3: Create a Research Paper that Compares Documentation Styles
This chapter discussed the requirements of the MLA documentation style. The American 
Psychological Association (APA) and the Chicago Manual of Style (CMS) are two other documentation 
styles supported by Word. Using the school library, this textbook, other textbooks, the Internet, 
magazines, or other sources, research the guidelines of the APA and CMS documentation styles to 
learn more about the differences among the MLA, APA, and CMS documentation styles. Using what 
you learn, write a short research paper (450-500 words) that compares the requirements and formats of 
the three documentation styles. Include at least two references and one explanatory note positioned as a 
footnote. Use the documentation style specifi ed by your instructor to format the paper. Check spelling 
and grammar of the fi nished paper.

•• 4: Create a Research Paper about the Month You Were Born

Make It Personal
Did you ever wonder what world events took place during the month you were born (besides your 
birth)? For example, what happened with respect to politics, world affairs, and the economy? What 
made headline news? Were there any scientifi c breakthroughs? What was on television and at the box 
offi ce? Were any famous people born? Did anyone famous die? What songs topped the charts? What 
was happening in the world of sports? Research the newsworthy events that took place during the 
month and year you were born (i.e., July 1981) by looking through newspapers, magazines, searching 
the Web, and/or interviewing family and friends. Write a short research paper (450-500 words) 
that summarizes your fi ndings. Include at least two references and one explanatory note. Use the 
documentation style specifi ed by your instructor to format the paper. Check spelling and grammar of 
the fi nished paper.

Continued >
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•• 5: Create a Research Paper about Spring Break Vacation Destinations

Working Together
With spring break just two months away, you and your fellow classmates are thinking about various 
spring break vacation destinations. Many options are available. Should you vacation close to home 
or travel across the country? Stay at a hotel, rent a condominium, or camp outdoors? Travel by car, 
train, or airplane? Book through a travel agent or the Web? Each team member is to research the 
attractions, accommodations, required transportation, and total cost of one spring break destination 
by looking through newspapers, magazines, searching the Web, and/or visiting a travel agency. Each 
team member is to write a minimum of 200 words summarizing his or her fi ndings. Each team member 
also is to write at least one explanatory note and supply his or her source information for the citation 
and bibliography. Then, the team should meet as a group to compose a research paper that includes all 
team members’ write-ups. Start by copying and pasting the text into a single document and then write 
an introduction and conclusion as a group. Use the documentation style specifi ed by your instructor to 
format the paper. Check spelling and grammar of the fi nished paper. Set the default dictionary. If Word 
fl ags any of your last names as an error, add the name(s) to the custom dictionary. Hand in printouts of 
each team member’s original write-up, as well as the fi nal research paper. 
 

Cases and Places continued
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